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EEDDII TTOORRII AALL

WELCOME TO ANOTHER ISSUE OF FULL CIRCLE.

I t's another full house. We have Python, LibreOffice, VAX-VMS, Inkscape, Arduino (of sorts) , andan extra HowTo, from me, on the absolute basics of using Audacity. I 'm no audio expert, so it's

pretty down and dirty, but that knowledge is what helps me make the Full Circle Weekly News.

Since I am now the proud owner of a BQ Aquaris M1 0 Ubuntu tablet (FHD), I thought I 'd better

review it for you folks. I won't spoil it, but suffice it to say: it's not perfect, but I hope future OTA's

will make it better than it already is. Oh, and, speaking of reviews, Greg is reviewing the book

Python Crash Course from No Starch Press.

Restoring life to old machines seems to be theme for this month's Linux Labs. Alan and Charles

both discuss using Ubuntu on old machines, but for different reasons.

I had hoped to discuss OTA-1 1 in this month's issue, but it's been delayed by at least a week, so

it'll be June before it arrives.

Elmer bids us farewell with part 60 being his last LibreOffice article. It's been a pleasure to

work with him over the years, and I wish him all the best. He knows the door is always open to

return with more LibreOffice, or something else.

As ever, don't be shy about sending in articles. We need them to keep going. Show, discuss,

review. Just write it up. Include (embedded in the article) screens/photos (JPG

format) and email it to me at the address below.

All the best, and keep in touch!

Ronnie

ronnie@fullcirclemagazine.org

This magazine was created using :

Find Full Circle on:

facebook.com/fullcircle

magazine

twitter.com/#!/fullcirclemag

goo.gl/FRTMl

http://issuu.com/fullcircle

magazine

http://www.magzter.com/

publishers/Full-Circle

Weekly News:
http: //ful lcirclemagazine.org

/feed/podcast

http: //www.stitcher.com/s?

fid=85347&refid=stpr

http: //tunein.com/radio/Ful l -

Circle-Weekly-News-

p855064/

mailto:ronnie@fullcirclemagazine.org
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http://creativecommons.org/
http://facebook.com/fullcirclemagazine
https://twitter.com/#!/fullcirclemag
http://goo.gl/FRTMl
http://issuu.com/fullcirclemagazine
http://www.magzter.com/publishers/Full-Circle
http://fullcirclemagazine.org/feed/podcast
http://www.stitcher.com/s?fid=85347&refid=stpr
http://tunein.com/radio/Full-Circle-Weekly-News-p855064/
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NVIDIA 364.1 9 SHORT-
LIVED LINUX DRIVER ADDS

VULKAN 1 .0 SUPPORT,
WAYLAND FIXES

The Short-Lived branch of the

Nvidia video driver usually gets

the latest improvements and fixes,

but it is not recommended to

stable users because it changes too

often and new releases are not

thoroughly tested. Nvidia 364.1 9 is

now the latest short-lived graphics

driver, and it looks like it brings

many interesting changes.

First, it adds support for the

Nvidia Quadro M6000 24GB and

Quadro M5500 graphics cards.

Then, we can see a new kernel

module, namely nvidia-drm.ko,

which has been engineered to

register itself as a DRM driver with

both DRM KMS and PRIME support,

as well as initial Direct Rendering

Manager Kernel Modesetting (DRM

KMS) support.

The Nvidia 364.1 9 short-lived

graphics driver also adds a new

RandR property called CscMatrix,

which can be used to specify a 3x4

color-space conversion matrix. As

usual, numerous issues have been

resolved, which you can see if you

click the changelog attached at the

end of the article.

Source:

http://news.softpedia.com/news/n

vidia-364-1 9-short-lived-unix-

driver-adds-vulkan-api-1 -0-support-

wayland-fixes-503325.shtml

HERE IS HOW YOU CAN FIX

LINUX SCHEDULE BUG

Earlier this month, according to

a lecture and paper delivered

at the EuroSys ’1 6 conference in

London, the Linux kernel scheduler

has deficits that stop a multicore

system from making proper use of

all cores for heavily multithreaded

loads.

However, now a patch is

available in a script provided by a

third party for those who are

running applications that might be

affected and do not wish to wait

for a solution from the kernel

team.

Titled “The Linux Scheduler: a

Decade of Wasted Cores,” the

paper was authored by a sextet of

researchers from the University of

British Columbia and four other

institutions. According to the

paper, there are four bugs in the

kernel scheduler that makes some

CPU cores stay idle even when

runnable threads are waiting to be

dispatched to a core.

Desktop users are not affected

by the bug. According to a

discussion thread on Hacker News,

the issue includes complications

that arise when using the Linux

scheduler on multiprocessor

systems. In certain circumstances,

the algorithm used by the

scheduler to balance the load

across cores flops. For example, a

thread that was asleep in the past

is woken up on an overloaded core,

when other cores are not in use.

The paper mentions one test

with apps written in the R language

that suggests how the issue might

Submitted by Arnfried Walbrecht

THE FULL CIRCLE

WEEKLY NEWS

A short podcast (<1 0min)

with just the news. No chit-

chat. No time wasting. Just

the latest FOSS/Linux/

Ubuntu news.

RSS:

http://fullcirclemagazine.

org/feed/podcast

http://news.softpedia.com/news/nvidia-364-19-short-lived-unix-driver-adds-vulkan-api-1-0-support-wayland-fixes-503325.shtml
http://fullcirclemagazine.org/feed/podcast
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arise when doing math and

statistical work in multicore Linux

environments.

The researchers say that such

bugs don’t always proclaim their

presence with a crash or a hang,

but rather via poor performance,

so they are not always noticeable.

Source:

http://www.techworm.net/201 6/0

4/can-fix-linux-schedule-bug.html

UBUNTU KYLIN 1 6.04 LTS
ARRIVES FOR THE CHINESE

LINUX COMMUNITY WITH

BOTTOM UNITY

U buntu Kylin 1 6.04 LTS was

officially launched as part of

the massive Ubuntu 1 6.04 LTS

(Xenial Xerus) release, and it

introduces many enhancements,

updated components, new tweaks

and under-the-hood optimizations,

as well as a brand-new Unity7

design with the Launcher placed at

the bottom of the screen by

default.

Powered by the same long-term

supported kernel as Ubuntu 1 6.04

LTS, Linux 4.4, Ubuntu Kylin 1 6.04

is also an LTS release supported for

five years with critical security fixes

and software updates. The Ubuntu

Kylin development team proved to

be very ingenious this cycle, and

we need to thank them for the

ability to have the Unity Launcher

at the bottom of the screen.

Release highlights of Ubuntu

Kylin 1 6.04 LTS (Xenial Xerus)

include a more concise and user-

friendly lock screen and display

manager, Ubuntu Kylin Software

Center as the default graphical

package manager, a revamped

version of the China Weather

Indicator, updated Sogou Chinese

Pinyin input method, and the latest

Kingsoft WPS office suite.

Source:

http://news.softpedia.com/news/u

buntu-kylin-1 6-04-lts-arrives-for-

the-chinese-linux-community-with-

bottom-unity-503338.shtml

XUBUNTU 1 6.04 LTS AND

LUBUNTU 1 6.04 LTS
RELEASED, GET THREE

YEARS OF SUPPORT

Xubuntu and Lubuntu are the

last two official Ubuntu

flavors released as part of the

massive Ubuntu 1 6.04 LTS (Xenial

Xerus) launch, and we're going to

tell you a little about their

presence.

First, we're going to tell all

about the Xubuntu 1 6.04 LTS

operating system, which had the

smallest presence of all the

Ubuntu flavors, and according to

the announcement, release

highlights include new community

wallpapers, and the replacement

of the Ubuntu Software Centre

app with the GNOME Software

graphical package manager.

While still based on the LXDE

desktop, Lubuntu 1 6.04 LTS'

presence was also quite small but a

bit better, with features like

massive artwork improvements for

both the desktop theme and the

icons, various updates to most of

the LXDE components, the

removal of the lubuntu-extra-

sessions component from the

default install, and several bug

fixes.

Source:

http://news.softpedia.com/news/x

ubuntu-1 6-04-lts-and-lubuntu-1 6-

04-lts-released-get-three-years-of-

support-503348.shtml

UBUNTU MATE 1 6.04 LTS
OFFICIALLY RELEASED FOR

RASPBERRY PI 3 AND

RASPBERRY PI 2

The Ubuntu MATE 1 6.04 for

Raspberry Pi port, which

comes hot on the heels of Lubuntu

1 6.04 LTS for Raspberry 2, has

been in development for the last

few months. Thus, since the Beta 2

build introduced at the beginning

of April, the team of developers

behind this project have

implemented several new tweaks

and much-needed improvements.

Among these, we can notice the

addition of OpenMAX IL hardware

accelerated video playback to the

VLC Media Player software,

requiring users to enable hardware

accelerated video playback via the

"OpenMax IL" option implemented

under Tools -> Preferences ->

Video. Moreover, there is full

support for Wi-Fi and Bluetooth

http://www.techworm.net/2016/04/can-fix-linux-schedule-bug.html
http://news.softpedia.com/news/ubuntu-kylin-16-04-lts-arrives-for-the-chinese-linux-community-with-bottom-unity-503338.shtml
http://news.softpedia.com/news/xubuntu-16-04-lts-and-lubuntu-16-04-lts-released-get-three-years-of-support-503348.shtml
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technologies for the Raspberry Pi

3 Model B SBC.

Source:

http://news.softpedia.com/news/u

buntu-mate-1 6-04-lts-officially-

released-for-raspberry-pi-3-and-

raspberry-pi-2-503395.shtml

UBUNTU 1 6.04 BRINGS

MORE PRIVACY AND BIG

CHANGES TO THE DESKTOP

The release of Ubuntu 1 6.04

last week is good news for

computer users who are upset

over the recent development of

Microsoft turning Windows into an

operating system that is

essentially spyware. As an open-

source Linux distribution, Ubuntu

is a great operating system for

users concerned about privacy.

This marks the 24th release of

the Ubuntu operating system,

which has become perhaps the

most popular Linux distribution in

the world. Ubuntu 1 6.04 —

codenamed Xenial Xerus — is also

the sixth Long Term Support (LTS)

release, meaning it will receive

free security updates and support

for five years. Canonical, the UK

software company which sponsors

Ubuntu, has continued to show its

commitment to providing a solid,

smooth, reliable, open-source

operating system for the desktop

even while working toward

convergence of the desktop, phone

and tablet into one seamless

operating system.

For Windows users looking for a

privacy-minded operating system,

this means that 1 6.04 stands on a

solid foundation and should prove

to be a good daily-driver.

Source:

http://www.thenewamerican.com/

tech/computers/item/23037-

ubuntu1 6-04-brings-more-privacy-

and-big-changes-to-the-desktop

UBUNTU LINUX AND

OPENSTACK CLOUD COME TO

IBM SERVERS

Last year, IBM introduced

LinuxONE, a new pair of IBM

mainframes along with Linux and

open-source software and services.

These new systems are the

LinuxONE Emperor, which built on

the IBM z1 3 mainframe and its

little brother, Rockhopper.

LinuxONE is the heart of IBM's

hybrid cloud efforts. At the

OpenStack Summit, Angel Diaz, VP

of IBM Cloud Architecture &

Technology, said LinuxONE with

Ubuntu and OpenStack can deliver

the "speed and flexibility that

businesses need to make the

Benjamins money."

Mark Shuttleworth, founder of

Canonical and Ubuntu, added that

"Ubuntu is all about enabling

users, such as Netflix, to create

work easily without friction. On

LinuxONE, you can just use Ubuntu

without needing to know anything

about the mainframe

architecture."

Source:

http://www.zdnet.com/article/ubu

ntu-linux-and-openstack-cloud-

come-to-ibm-servers/

ARTIFICIAL INTELLIGENCE

NOW FITS INSIDE A USB
STICK

Movidius chips have been

showing up in quite a few

products recently. It's the company

that helps DJI 's latest drone avoid

obstacles, and FLIR's new thermal

camera automatically spot people

trapped in a fire, all through deep

learning via neural networks. It

also signed a deal with Google to

integrate its chips into as-yet-

unannounced products. Now, the

chip designer has a product it says

will bring the capacity for powerful

deep learning to everyone: a USB

accessory called the Fathom

Neural Compute Stick.

The Fathom contains the Myriad

2 MA2450 VPU paired with 51 2MB

of LPDDR3 RAM. The Myriad 2 is

the chip found in the previously

mentioned DJI and FLIR products.

It's able to handle many processes

simultaneously, which is exactly

what neural networks call for.

Because it's specifically designed

for this -- its architecture is very

different from the GPUs and CPUs

that typically handle processing --

it offers a lot of grunt without

requiring much power. It can

handle up to 1 50 gigaFLOPS (1 50

billion floating-operations per

second) while consuming no more

than 1 .2 watts.

Unlike Tegra's solutions for

deep learning, the Fathom isn't a

standalone system. The idea is you

plug it into the USB 3.0 port of any

system running Linux to get a "20-

http://news.softpedia.com/news/ubuntu-mate-16-04-lts-officially-released-for-raspberry-pi-3-and-raspberry-pi-2-503395.shtml
http://www.thenewamerican.com/tech/computers/item/23037-ubuntu16-04-brings-more-privacy-and-big-changes-to-the-desktop
http://www.zdnet.com/article/ubuntu-linux-and-openstack-cloud-come-to-ibm-servers/
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30x performance improvement in

neural compute." You can use the

Fathom to rapidly prototype neural

networks, moving to something

with a lot more power once you're

ready to deploy.

Source:

http://www.engadget.com/201 6/0

4/28/movidius-fathom-neural-

compute-stick/

LINUX KERNEL 3.1 2.59 LTS
OUT NOW WITH CRYPTO &
NETWORKING FIXES,
UPDATED DRIVERS

Linux kernel developer Jiri Slaby

announced the availability of

the fifty-ninth maintenance

release of the long-term

supported Linux 3.1 2 kernel series,

urging all users to update as soon

as possible.

Looking at the appended

shortlog, we can notice that Linux

kernel 3.1 2.59 LTS is here to patch

various security issues that have

been discovered since the previous

point release, version 3.1 2.58,

which was announced two weeks

ago, along with an important piece

of information, that the Linux 3.1 2

series will be supported until 201 7

because it is used in SUSE Linux

Enterprise 1 2.

Source:

http://news.softpedia.com/news/li

nux-kernel-3-1 2-59-lts-out-now-

with-crypto-networking-fixes-

updated-drivers-503495.shtml

MOZILLA FIREFOX 46.0
LANDS IN ALL SUPPORTED

UBUNTU OSES WITH GTK3
INTEGRATION

Mozilla Firefox 46.0 is a pretty

small release of the popular

web browser, which is used by

default in numerous GNU/Linux

operating systems, including

Ubuntu. It's worth mentioning that

it only brings improved security to

the JavaScript JIT (Just In Time)

compiler, more WebRTC

performance and stability

enhancements, and various

security fixes.

Of course, there were also a

few other minor changes, such as

better rendering for scaled SVGs

(Scalable Vector Graphics) that use

a mask and a clip, improvements to

the screen reader behavior with

blank spaces for Google Docs,

support for the

document.elementsFromPoint

HTML5 element, and HKDF

support for the Web CryptoAPI .

Mozilla Firefox 46.0 web

browser has finally been

introduced for all supported

Ubuntu Linux operating systems,

including Ubuntu 1 6.04 LTS (Xenial

Xerus) , Ubuntu 1 5.1 0 (Wily

Werewolf) , Ubuntu 1 4.04 LTS

(Trusty Tahr) , and Ubuntu 1 2.04 LTS

(Precise Pangolin) , so please

update as soon as possible.

Source:

http://news.softpedia.com/news/

mozilla-firefox-46-0-lands-in-all-

supported-ubuntu-oses-with-gtk3-

support-503489.shtml

ORACLE RELEASES

VIRTUALBOX 5.0.20 WITH

FIXES FOR LINUX KERNEL

4.5, SMALL CHANGES

Oracle has announced the

release of VirtualBox 5.0.20,

yet another maintenance version

of its acclaimed open-source and

cross-platform virtualization

software.

According to the release notes,

Oracle VirtualBox 5.0.20 is a pretty

small release that comes only one

and a half weeks after the previous

maintenance build, VirtualBox

5.0.1 8, which introduced initial

support for the upcoming Linux 4.6

kernel.

Changes in today's VirtualBox

5.0.20 release include more fixes

for the Linux kernel 4.5 series,

especially when the

CONFIG_NET_CLS_ACT variable is

enabled, support for listing

processor features on

VBoxManage's list hostinfo, TCP

support in the DNS proxy feature,

as well as better handling of port-

forwarding rules.

Source:

http://news.softpedia.com/news/o

racle-releases-virtualbox-5-0-20-

with-fixes-for-linux-kernel-4-5-

small-changes-503525.shtml

http://www.engadget.com/2016/04/28/movidius-fathom-neural-compute-stick/
http://news.softpedia.com/news/linux-kernel-3-12-59-lts-out-now-with-crypto-networking-fixes-updated-drivers-503495.shtml
http://news.softpedia.com/news/mozilla-firefox-46-0-lands-in-all-supported-ubuntu-oses-with-gtk3-support-503489.shtml
http://news.softpedia.com/news/oracle-releases-virtualbox-5-0-20-with-fixes-for-linux-kernel-4-5-small-changes-503525.shtml
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ELEMENTARY OS 0.4 "LOKI"
TO BE BASED ON UBUNTU

1 6.04, PROMISES BIG NEW

FEATURES

N ow that Canonical has

launched its most anticipated

Ubuntu release, the Xenial Xerus,

a.k.a. Ubuntu 1 6.04 LTS, it looks

like the elementary OS community

has flooded the forums with

questions about the release date

of the elementary OS 0.4 "Loki"

operating system, which has now

been finally confirmed as being

based on Ubuntu 1 6.04.

Elementary OS 0.4 "Loki" is

coming, and it promises big new

features, which have not yet been

revealed by the team of hard-

working people behind what was

previously known as the "most

beautiful Linux distro." However,

we do know there'll be better

HiDPI support and, of course, the

integration of the Birdie Twitter

client.

Source:

http://news.softpedia.com/news/e

lementary-os-0-4-loki-to-be-based-

on-ubuntu-1 6-04-promises-big-

new-features-503536.shtml

WHAT’S ON TAP FOR LINUX

CONTAINER TECHNOLOGY IN

201 6

White hot interest in

containers has been driven

by cloud computing’s demand to

simplify deployment, streamline

time to production, and

automatically deliver the resources

an application needs. Linux

containers provide that in a nice

package: a simple tool for

developing, testing and delivering

an application to the end user.

Containers are designed to

make it easier and quicker for

developers to create complete

application operating

environments. Gone is the painful

validation process of traditional

application deployments that

require developers to identify the

minimum system requirements

needed to run the application.

There are other important

benefits. Linux containers package

just about any type of server

application to run everywhere – on

your desktop, in a cloud, or

anywhere Linux is available –

regardless of kernel version or

Linux distribution. Containers also

can have a considerably smaller

footprint than VMs, which means

your systems can see higher

densities and run more cost

effectively with containers than

with VMs on the same host.

Source:

http://www.networkworld.com/art

icle/3065049/cloud-

computing/what-s-on-tap-for-linux-

container-technology-in-201 6.html

NO UBUNTU BACK DOORS,
WINDOWS AND MAC

MIGRATIONS

Mark Shuttleworth said in an

interview with eWeek.com

today, "We will never backdoor

Ubuntu." He said, "We don't do

encryption to hide things; we do

encryption so we can choose what

to share. We will never weaken

encryption." Watch the full

interview for more on Ubuntu

development, in particular plans

for Mir. Speaking of Ubuntu,

another announcement coming out

of the UOS is that the size limit of

Ubuntu desktop image will be

raised. Releases surpassed the

limit a while back anyway, so

they're making it official according

to OMG!Ubuntu! The new limit is

up from one gigabyte to two.

OMG!Ubuntu! also posted of

Ubuntu in the wild, April 201 6

edition. And finally, one more

Ubuntu note, Jesse Smith said

today of 1 6.04, "Ubuntu 1 6.04 is a

very nice release."

Source:

http://ostatic.com/blog/no-

ubuntu-back-doors-windows-and-

mac-migrations

BEAUTIFUL SIMPLICITY

LINUX 1 6.04 OS ARRIVES,
BASED ON LXPUP AND THE

LXDE DESKTOP

Simplicity Linux 1 6.04 is

distributed in three main

editions, namely Desktop, X, and

Mini. The distribution has been in

development for the past three

months, since February, when it

was initially released as Simplicity

Linux 1 6.01 .

Since then, the development

team behind the Simplicity Linux

project has managed to seed Alpha

http://news.softpedia.com/news/elementary-os-0-4-loki-to-be-based-on-ubuntu-16-04-promises-big-new-features-503536.shtml
http://www.networkworld.com/article/3065049/cloud-computing/what-s-on-tap-for-linux-container-technology-in-2016.html
http://ostatic.com/blog/no-ubuntu-back-doors-windows-and-mac-migrations
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and Beta builds to early adopters

and public beta testers who

volunteered to help them polish

the final release of the operating

system before it hit the streets,

which happened on May 2, 201 6,

after a small delay.

Being based on the excellent

and lightweight LXPup GNU/Linux

distribution, and built around the

LXDE desktop environment,

Simplicity Linux 1 6.04 is powered

by a kernel from the 4.0 series

(Linux 4.0.4) on the Desktop and

Mini editions, and Linux kernel

4.4.5 LTS on the X flavor, which is

the experimental branch of the OS,

where all the bleeding-edge stuff

happens before it lands in the

more stable Desktop and Mini

editions.

Source:

http://news.softpedia.com/news/b

eautiful-simplicity-linux-1 6-04-os-

arrives-based-on-lxpup-and-the-

lxde-desktop-503654.shtml

HP LINUX IMAGING AND

PRINTING 3.1 6.5 SUPPORTS

UBUNTU 1 6.04 LTS AND

DEBIAN 8.4

The team of developers behind

the HPLIP (short for HP Linux

Imaging and Printing) project,

announced the availability of the

fifth maintenance build in the 3.1 6

stable series of the software.

Today's release of HP Linux

Imaging and Printing 3.1 6.5 is

proof that the project is getting

stronger with each day, offering

you support for more HP printers

than any other proprietary

software. Newly supported HP

printers in HPLIP 3.1 6.5 include HP

OfficeJet 200 mobile printer series

and HP OfficeJet Pro 871 0 all-in-

one printer.

Furthermore, the HP OfficeJet

Pro 871 5 all-in-one printer, HP

OfficeJet Pro 8740 all-in-one

printer, HP OfficeJet Pro 8720 all-

in-one printer, HP OfficeJet Pro

8725 all-in-one printer, HP LaserJet

Pro M501 n, and HP LaserJet Pro

M501 dn printers are also

supported by the HP Linux Imaging

and Printing 3.1 6.5 release.

Source:

http://news.softpedia.com/news/h

p-linux-imaging-and-printing-3-1 6-

5-supports-ubuntu-1 6-04-lts-and-

debian-8-4-50371 2.shtml

CANONICAL ANNOUNCES

THE AVAILABILITY OF

UBUNTU CORE FOR

SAMSUNG ARTIK 5 AND 1 0

Thibaut Rouffineau, an IoT &

Ubuntu Core evangelist, has

announced the availability of

Canonical's Ubuntu Core operating

system for Samsung ARTIK 5 and

1 0 IoT (Internet of Things)

platforms.

Those of you who have been

waiting to get their hands on the

Ubuntu Core developer images for

the Samsung ARTIK 5 and Samsung

ARTIK 1 0 boards should know that

they are available for download for

free from the

https://developer.ubuntu.com/en/s

nappy/start/samsung-artik-iot-

modules/ website.

These Ubuntu Core images will

give developers access to a

number of technologies of the two

Samsung ARTIK IoT boards,

including but not limited to Wi-Fi

and Bluetooth, and they can also

be used as a starting platform to

build their next Internet of Things

applications and devices.

Source:

http://news.softpedia.com/news/c

anonical-announces-the-

availability-of-ubuntu-core-for-

samsung-artik-5-and-1 0-

503744.shtml

M23 ROCK 1 6.2 LINUX

DEPLOYMENT TOOL ADDS

SUPPORT FOR UBUNTU

1 6.04 LTS CLIENTS

m23 Rock 1 6.2 comes exactly

three months after the

release of the Rock 1 6.1 version,

which was a small update

introducing support for the

Univention Corporate Server (USC)

and Linux Mint 1 7.3 "Rosa"

operating systems, and it looks like

it includes some very interesting

additions, along with the usual bug

fixes and improvements.

Probably the most important

new feature added in the m23

Rock 1 6.2 update is the support for

Canonical's recently released

Ubuntu 1 6.04 LTS (Xenial Xerus)

operating system, which means

that you can now use m23 to make

large-scale deployments of this OS.

http://news.softpedia.com/news/beautiful-simplicity-linux-16-04-os-arrives-based-on-lxpup-and-the-lxde-desktop-503654.shtml
http://news.softpedia.com/news/hp-linux-imaging-and-printing-3-16-5-supports-ubuntu-16-04-lts-and-debian-8-4-503712.shtml
https://developer.ubuntu.com/en/snappy/start/samsung-artik-iot-modules/
http://news.softpedia.com/news/canonical-announces-the-availability-of-ubuntu-core-for-samsung-artik-5-and-10-503744.shtml
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The devs have also noted the

fact that a set of desktop

environments is available too for

Ubuntu 1 6.04 LTS deployments.

These include the popular Unity, as

well as KDE, Xfce, LXDE, and

MATE. It also looks like they had to

make a lot of adjustments to the

systemd init system

implementation of Ubuntu 1 6.04

LTS, which didn't work as expected.

Source:

http://news.softpedia.com/news/

m23-rock-1 6-2-linux-deployment-

tool-adds-support-for-ubuntu-1 6-

04-lts-clients-503784.shtml

UBUNTU 1 6.1 0 (YAKKETY

YAK) WILL SOON BE

POWERED BY LINUX KERNEL

4.6

At the end of April, the Ubuntu

developers have announced

that the development of the next

major release of the Debian-based

operating system, Ubuntu 1 6.1 0

(Yakkety Yak), is officially open,

which means that they will start

uploading new package versions,

sync the repositories with

upstream, fix potential issues, and

rebase the kernel packages, as

everything right now in Yakkety is

based on Xenial.

The Ubuntu 1 6.1 0 (Yakkety Yak)

daily build live ISO images have

been made available for download

immediately after the April 21 st

release of Ubuntu 1 6.04 LTS (Xenial

Xerus) , for early adopters, but

most, if not all, of the packages,

have the same versions as those in

Ubuntu 1 6.04 LTS, including the

kernel. But it looks like that will

change soon, and Ubuntu 1 6.1 0

will be powered by Linux kernel

4.6.

Source:

http://news.softpedia.com/news/u

buntu-1 6-1 0-yakkety-yak-will-soon-

be-powered-by-linux-kernel-4-6-

50381 2.shtml

FREE AS CAN BE:
GNEWSENSE IS TRUE GNU
LINUX

The Free Software Foundation-

supported Linux distribution

gNewSense is finally out in its

fourth revision after a two-plus-

year development cycle.

The FSF is best known for its

unrelenting advocacy for software

unencumbered by patents and

protected for future use by the

GPL, as embodied in software like

the Linux kernel and the GNU

toolchain. The gNewSense Linux

distribution is assembled with the

FSF's goal in mind of having no

dependencies at all on proprietary

binaries or other components that

aren't compatible with the GPL.

Earlier gNewSense releases

used Ubuntu as the base, but the

project switched to Debian (from

which Ubuntu was derived)

because it already performs a lot

of the work needed to remove

GPL-incompatible elements.

Source:

http://www.infoworld.com/article/

3067280/open-source-tools/free-

as-can-be-gnewsense-is-true-gnu-

linux.html

BLACK LAB SOFTWARE

ANNOUNCES BLACK LAB

CLOUDBOOK PC AS A

CHROMEBOOK

REPLACEMENT

Black Lab NetOS is the

company's brand-new cloud-

oriented, Web-centric Linux kernel-

based operating system, which

Black Lab Software considers is the

perfect ChromeOS replacement. In

the same manner, the Black Lab

Cloudbook computer comes as an

alternative to Chromebooks.

Black Lab Software's NetOS

operating system is based on

Ubuntu Linux, but it differs from

the main Black Lab Linux

distribution in the way that it only

uses cloud applications, just like

Google's ChromeOS. However,

users will also have direct access to

the main Ubuntu software

repositories to install any of the

available packages.

The Black Lab NetOS operating

system is built around the Xfce

4.1 2 desktop environment and

includes popular applications like

VLC Media Player, Google Chrome,

and Skype, along with numerous

Web Apps, such as Twitter,

Facebook, Facebook Messenger,

Netflix, Hulu, Outlook, Microsoft

Office Online, or Slack.com.

http://news.softpedia.com/news/m23-rock-16-2-linux-deployment-tool-adds-support-for-ubuntu-16-04-lts-clients-503784.shtml
http://news.softpedia.com/news/ubuntu-16-10-yakkety-yak-will-soon-be-powered-by-linux-kernel-4-6-503812.shtml
http://www.infoworld.com/article/3067280/open-source-tools/free-as-can-be-gnewsense-is-true-gnu-linux.html
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Source:

http://news.softpedia.com/news/b

lack-lab-software-announces-black-

lab-cloudbook-pc-as-a-

chromebook-replacement-

503876.shtml

CONFIGURING LINUX USAGE

LIMITS WITH DOCKER AND

AWS ECS

Linux has become a dominant

OS for application back ends

and micro-services in the cloud.

Usage limits (aka ulimits) are a

critical Linux application

performance tuning tool. Docker is

now the leading mechanism for

application deployment and

distribution and AWS ECS is one of

the top Docker container services.

It's more important than ever for

developers to understand ulimits

and how to use them in Linux,

Docker and a service like AWS ECS.

The purpose of ulimits is to

limit a program's resource

utilization to prevent a runaway

bug or security breach from

bringing the whole system down. It

is easy for modern applications to

exceed default open file limits very

quickly.

Limits are a critical application

tuning parameter. Cloud Docker

services have their own mechanism

for configuring ulimits.

Source:

http://www.computerworld.com/ar

ticle/3067303/cloud-

computing/how-to-configuring-

linux-usage-limits-with-docker-and-

aws-ecs.html

LINUX KERNEL 4.5.4 IS OUT,
BRINGS AMDGPU, ARM,
INTEL I91 5, WIRELESS, X86
UPDATES

Kernel developer Greg Kroah-

Hartman announced the

release of the fourth maintenance

build in the latest stable and most

advanced Linux 4.5 kernel branch.

While not many GNU/Linux

operating systems have adopted

Linux kernel 4.5, its development

cycle continues at a fast pace,

introducing more and more

improvements, security patches,

and new capabilities. According to

the appended shortlog, which also

includes the diff from the previous

maintenance release, Linux 4.5.3,

the new update changes a total of

97 files, with 600 insertions and

238 deletions.

The biggest changes in Linux

kernel 4.5.4 are updated drivers, in

particular for things like GPU

(mostly Intel i91 5 and AMDGPU),

ACPI , ATA, CLK, CPUFreq, CPUIdle,

general-purpose input/output

(GPIO), HID, i iO, InfiniBand,

LightNVM, MD, MFD, NVDIMM,

NVMEM, PWM, SCSI , SoC, USB,

Xen, and networking

Source:

http://news.softpedia.com/news/li

nux-kernel-4-5-4-is-out-brings-

amdgpu-arm-intel-i91 5-wireless-

x86-updates-503966.shtml

CANONICAL PUSHES NEW

FEATURES INTO THE SNAPPY

INTEGRATION FOR UBUNTU

1 6.04 LTS

Canonical's Zygmunt Krynicki

has announced that a new

version of the snapd tool has been

pushed to the stable repositories

of Ubuntu 1 6.04 LTS.

snapd 2.0.3 is the latest and

most advanced version of the tool

used in the latest Ubuntu 1 6.04 LTS

(Xenial Xerus) operating system to

interact with the Snappy

infrastructure of Ubuntu Core, a

variant of the Ubuntu Linux OS

designed for embedded and IoT

devices.

The list of changes

implemented in snapd 2.0.3

continues with BlueZ interface

improvements, the removal of the

unused SetProperty function and

D-Bus code, the addition of short

and long description to snapd's

man-page, improvements to the

handling of snap sideload form, as

well as re-enablement of several

integration tests.

Source:

http://news.softpedia.com/news/c

anonical-pushes-new-features-

into-the-snappy-integration-for-

ubuntu-1 6-04-lts-50401 4.shtml

UBUNTU-BASED EXTON|OS
LINUX DISTRIBUTION NOW

SHIPS WITH MATE 1 .1 4,
VLC 2.2.3

Earlier this week, we reported

on the release of a new build

http://news.softpedia.com/news/black-lab-software-announces-black-lab-cloudbook-pc-as-a-chromebook-replacement-503876.shtml
http://www.computerworld.com/article/3067303/cloud-computing/how-to-configuring-linux-usage-limits-with-docker-and-aws-ecs.html
http://news.softpedia.com/news/linux-kernel-4-5-4-is-out-brings-amdgpu-arm-intel-i915-wireless-x86-updates-503966.shtml
http://news.softpedia.com/news/canonical-pushes-new-features-into-the-snappy-integration-for-ubuntu-16-04-lts-504014.shtml
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of the Ubuntu-based Exton|OS

Linux distribution, version 1 6051 2,

which was rebased on Ubuntu

1 6.04 LTS (Xenial Xerus).

However, it was a bit strange

that the distro shipped with an

older version of the MATE desktop

environment, a clone of the old-

school GNOME 2 (also known as

GNOME Classic) graphical

interface, version 1 .1 2.7, despite

the fact that MATE 1 .1 4 was

released last month.

Therefore, at the request of the

community, Arne Exton had to

upgrade the MATE package to the

latest stable branch, version

1 .1 4.0, which, unfortunately, he

had to build from the freely

distributed sources. The reason for

that is because it looks like the

MATE 1 .1 4 desktop environment is

not yet available in the main

repositories of Ubuntu 1 6.04 LTS.

Source:

http://news.softpedia.com/news/u

buntu-based-exton-os-linux-

distribution-now-ships-with-mate-

1 -1 4-vlc-2-2-3-504071 .shtml

NEW ARDUINO SRL SBC
MERGES ARDUINO, WIFI,
AND LINUX

Arduino Srl’s new “Arduino

Industrial 1 01 ” SBC includes

Arduino circuitry and I/O, along

with a soldered-on WiFi module

that runs Linino Linux.

Last November, Arduino Srl

promised an Arduino Industrial 1 01

carrier board for Dog Hunter’s

WiFi-enabled Chiwawa module,

which is supported by the

OpenWrt-based Linino Linux

distribution. Arduino has now

unveiled the resulting product: a

$40, sandwich-style single board

computer with a soldered-on,

Arduino-branded version of the

Chiwawa module, along with Linino

Linux support.

The sandwich-style Arduino

Industrial 1 01 SBC, which includes

the Chiwawa LGA WiFi module

soldered on-board, is currently

listed at Arduino Srl’s shipping

page for 35 Euros ($40).

Source:

http://hackerboards.com/new-

arduino-srl-sbc-merges-arduino-

wifi-and-linux/

UBUNTU BUDGIE 1 6.1 0
NOW IN DEVELOPMENT,
BRINGS NEW BOOT SPLASH,
WELCOME SCREEN

Budgie-Remix (soon to become

Ubuntu Budgie) developer

David Mohammed has informed

about the availability of the

project's first-ever newsletter for

the community.

The newsletter is called Budgie-

Remix Roundup, and the first

installation is now live on the

project's website, informing users

about the latest innovations

implemented in the operating

system, whose main design goal is

to give users an officially

recognized Ubuntu flavor built

around the Budgie desktop from

the Solus Project.

From the newsletter, it looks

like there are a few interesting

things that are coming to Budgie-

Remix very soon, targeting both

the stable Budgie-Remix 1 6.04 and

the now-in-development Budgie-

Remix 1 6.1 0 release. Among them

is a new boot splash screen for

Plymouth.

Furthermore, a Welcome to

Budgie-Remix/Ubuntu Budgie app

will be available soon for the

upcoming Budgie-Remix 1 6.04.1

release, as well as in the final

Budgie-Remix 1 6.1 0 release, which

the team hopes to rename to

Ubuntu Budgie if the distribution is

accepted as an official flavor, which

Mark Shuttleworth himself said he

would endorse.

Source:

http://news.softpedia.com/news/u

buntu-budgie-1 6-1 0-now-in-

development-brings-new-boot-

splash-welcome-screen-

504087.shtml

LINUX 4.6 TARGETS MOBILE

WITH ARM, TOUCH SUPPORT

Aside from security

improvements, version 4.6 of

the Linux kernel, released over the

weekend, offers enhancements for

ARM processors and touchscreens.

Embedded ARM support in the

upgrade features backing for 1 3

SoCs (system on a chip) , including

systems from Allwinner, LG,

Qualcomm, and Broadcomm. WiFi

routers, the Nexus 7 smartphone,

http://news.softpedia.com/news/ubuntu-based-exton-os-linux-distribution-now-ships-with-mate-1-14-vlc-2-2-3-504071.shtml
http://hackerboards.com/new-arduino-srl-sbc-merges-arduino-wifi-and-linux/
http://news.softpedia.com/news/ubuntu-budgie-16-10-now-in-development-brings-new-boot-splash-welcome-screen-504087.shtml
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and the Raspberry Pi

nanocomputer, all will have

improved support for their boards,

according to the Linux Foundation.

The new version corrects an

Infiniband interface problem as

well. Linux creator Linus Torvalds

said earlier this month that few

would be affected by this problem

anyway, and a workaround had

been available.

Source:

http://www.infoworld.com/article/

3071 1 1 3/linux/linux-46-targets-

mobile-with-arm-touch-

support.html

UBUNTU CORE NOW READY

FOR SCREENLY, A DIGITAL

SIGNAGE SOLUTION FOR

RASPBERRY PI

Canonical has announced a

partnership with Screenly to

bring the Snappy Ubuntu Core

operating system to the world's

most popular digital signage

solution for the Raspberry Pi.

As many of you are already

aware from our previous coverage,

Snappy Ubuntu Core is a slimmed-

down version of the Ubuntu Linux

operating system, engineered by

Canonical for deployments on a

broad range of embedded and IoT

(Internet of Things) devices, such

as Raspberry Pi single-board

computers.

Currently, Canonical provides

developers and IoT enthusiasts

with binary images of the Snappy

Ubuntu Core operating system

only for the Raspberry Pi 2 SBC,

but images for the recently

released Raspberry Pi 3 Model B

are in the works and will be

released later this year, most

probably along with the Snappy

Ubuntu Core 1 6 build.

Screenly is the most popular

digital signage solution for the

Raspberry Pi, and it looks like they

recently joined forces with

Canonical to build their

infrastructure around the Snappy

Ubuntu Core operating system,

offering their customers a secure,

stable, easy-to-use, robust, and

simple-to-manage digital signage

platform for Raspberry Pi boards.

Source:

http://news.softpedia.com/news/u

buntu-core-now-ready-for-

screenly-a-digital-signage-solution-

for-raspberry-pi-504200.shtml

PURISM INTRODUCES

PRIVACY-FOCUSED, LINUX

TABLETS FOR $599 AND UP

Purism is expanding its line of

Linux-based computers with

an emphasis on security, privacy,

and open source software. The

company’s new Librem 1 0 is a

Linux-based tablet with a 1 0 inch

display and a starting price of

$599, while the Librem 1 1 is a

higher-powered model with a

bigger screen and a starting price

of $999 for early backers of an

Indiegogo crowdfunding campaign.

Both tablets are expected to ship

starting in September.

Purism has been running

crowdfunding campaigns for Linux-

based laptops for a few years, but

the company has sort of shifted its

sales pitch a bit in the past year or

so. Instead of promising a

completely open experience (since

the BIOS typically uses proprietary

blobs) , the company is instead

focusing on privacy.

One of the most unusual

features of the Librem 1 0 and

Librem 1 1 tablets will be “privacy

kill switches,” which are hardware

buttons that will disconnect the

webcam, microphone, WiFi, and

Bluetooth.

Source:

http://liliputing.com/201 6/05/puris

m-introduces-privacy-focused-

linux-tablets-599.html

http://www.infoworld.com/article/3071113/linux/linux-46-targets-mobile-with-arm-touch-support.html
http://news.softpedia.com/news/ubuntu-core-now-ready-for-screenly-a-digital-signage-solution-for-raspberry-pi-504200.shtml
http://liliputing.com/2016/05/purism-introduces-privacy-focused-linux-tablets-599.html
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I ’ve always been a fan ofelectronics - be it Arduino, full-

on computers, or something like a

Raspberry Pi. However, I always try

to balance out my purchases with

actual need - which means I have

never owned a Raspberry Pi. Until

now. I recently ordered a model 3

off Amazon (in a complete bundle

with a case, power supply and

heatsinks - the SD card was

missing, but as I own many of

them, it wasn’t necessary). The

intended use for this Raspberry Pi

was to connect it to our older

Brother MFC-230C printer - which

is USB only. There were two

reasons for this - firstly, heading to

the office to manually connect a

USB printer was a pain, and

secondly, I wanted some method

with which I could enable Google

Cloud Print. For those who don’t

know - Google Cloud Print is a

service that allows printing from

android tablets/phones and

chromebooks to a printer

connected to another computer.

The small form-factor, and built-in

wireless, in the model 3 made this

a terrific way to connect the

printer to our LAN – without

having to leave a desktop

computer or laptop running all the

time.

The main reason I selected this

kit was because this bundle

shipped with Amazon Prime – the

other bundles had additional

shipping costs.

WHAT ARE YOU COVERING?

I ’m going to focus on the setup

of the Raspberry Pi (RPi) this

month. Once I ’ve given myself

sufficient time to test out the

CUPS setup and Google cloud

print, I will follow this article up

with those exact steps.

WHAT DO I NEED?

You’ll need a Raspberry Pi (and

an SD card that is >= 4GB), a

keyboard, a mouse, and a monitor.

The last 3 items you’ll need only

for the actual installation of

raspbian - everything else can be

done via SSH or VNC later.

Logically, you’ll also need some

device to download and copy the

NOOBS installer from the

Raspberry Pi website to the SD

card.

NOOBS installer:

https://www.raspberrypi.org/down

loads/noobs/

NOTE 1 : There is also a manual

installer, but I focused on the most

typical use-case.

NOTE 2: There are torrents as well

as direct downloads - but the

torrents failed to work in rtorrent.

HEATSINKS - DO I NEED

THEM?

Heatsinks shouldn’t really be

necessary at all - most people

agree that even under the most

extreme conditions, the RPi will be

fine without. However, heatsinks

may be beneficial for me, as the

RPi will probably be operating in a

slightly stuffy room, with a high

chance of direct sunlight via the

window. Heatsinks may help keep

the RPi a little cooler in these

positions. As the RPi seems to lack

any sensors (for use with lm-

sensors) , I can’t make any

temperature comparisons.

STEP 0: ASSEMBLY & PREP

I can’t offer exact instructions

here, as it all depends on your case

(or lack thereof). It shouldn’t be a

difficult process.

For the SD card, the official site

recommends a tool for Windows or

Mac. But if you’d rather do it by

hand, the SD card just seems to

need to be FAT32 (should be the

standard for any size less than and

including 32GB), or FAT1 6.

Unfortunately, any SD card that is

> 32GB will be exFAT by default. In

any case, I recommend

reformatting just to be safe. After

that, copy all the extracted files

from the archive onto the SD card.

Eject it, and insert it into the

underside of your RPi.

STEP 1 : INSTALLATION

Once the case is set up, and the

SD card ready, you’ll want to

CCOOMMMMAANN DD && CCOONN QQUU EERR
Written by Lucas Westermann

RRaa ssppbbeerrrryy PPii MMoodd eell 33 SSeettuu pp

http://pastebin.com/eLASuY1T
https://www.raspberrypi.org/downloads/noobs/
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connect your peripherals, and then

boot the device (by plugging in the

power supply) .

The RPi will then boot to a very

basic screen. You can either

connect to the internet and

download/install something other

than Raspbian - or just select

Raspbian and choose “Install”

(Recommended). I ’ve used

Raspbian for this project. After

that, you’ll need to just wait out

the installation.

STEP 2: BOOTED UP - NOW

WHAT?

The first thing I did was connect

my wireless, and tried to set a

static IP (as my router doesn’t

allow reserving IP addresses). The

GUI tool seems to just add an entry

into /etc/dhcpcd.conf with ssid

information. This does seem to

work - but resulted in the issue

that the static IP was used for

whatever interface came up first -

so if I was using ethernet, it was

used there instead (which

shouldn’t be the case as it lacks an

SSID). In order to solve this (as I

want ethernet to run via DHCP -

that way I can connect it directly to

a laptop for debugging), I simply

added the following line directly

above the ssid line:

Interface wlan0

This tells dhcpcd to apply the

following settings only for the

wireless interface - so ethernet

runs normally on DHCP, and my

wireless will use the static IP I

chose when connected to my home

network. Other wireless networks

should default back to DHCP (so

you’ll never run into the issue that

the RPi is assuming the wrong

subnet). I have yet to test the RPi

with another wireless network.

Once you have your IP reserved

in your router, or statically

assigned by the RPi, you’re ready

to disconnect your

keyboard/mouse/monitor, and

switch to SSH (if you prefer) . I ’ll

also cover installing tightvnc and

using that, so you have access to

the GUI apps.

STEP 2.1 : TIGHTVNC

TightVNC is a VNC (Virtual

Network Computing) client that is

offered in the Raspbian repos. To

install it just run:

sudo apt-get install
tightvncserver

Once it’s installed, simply start

it by running the command:

tightvncserver

This should result in some

information in the terminal, telling

you there is a new ‘X’ desktop. To

save resources, I recommend

killing the X session on :0, with:

service lightdm stop

STEP 2.1 .1 : CONNECTING

I f you use vncviewer on a Linux

machine, just using the IP followed

by the display number, you’ll be

fine. Such as 1 92.1 68.0.1 5:1 . If

you’re trying to connect using OS

X’s integrated screen sharing

application, it will need to be a

port - 5900 = :0, 5901 = :1 , etc. So

1 92.1 68.0.1 5:5901 would work

there. I haven’t tested a

connection on Windows, but one

of the two options above should

work.

If you set a password, keep in

mind that RPi truncates passwords

to 8 characters - so if a password

isn’t working, make sure it’s not

too long - and if it is, just stop

typing it after 8 characters.

STEP 2.2: AUTOSTART

I used the Raspberry Pi

Configuration tool to boot

automatically into the CLI - as I

only need SSH access, and the

occasional VNC call.

If you want to automatically

start a VNC session, I would

recommend looking at the official

documentation:

https://www.raspberrypi.org/docu

mentation/remote-access/vnc/

STEP 3: APPLICATIONS

Depending on what you want to

do with the RPi, you may need to

install other packages. In my case, I

need to install the packages

chromium-inspector (chromium

browser - required for Cloud Print) ,

and cups (for sharing the printer

normally) .

There are various articles out

there for exact steps, so here are

just a list of a few things people

may want to install/enable:

• Bittorrent Sync (for sharing files) .

• Bluetooth (requires various

https://www.raspberrypi.org/documentation/remote-access/vnc/
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packages - such as bluez bluez-

hcidump, bluez-tools, blueman,

etc) . As this depends on whether

you want GUI tools or not, I ’d

recommend following a guide that

installs just what you need.

• LAMP - for running a web server.

• Docker - I ’m not sure how well

Docker would run on an RPi, but of

the virtualization options I can

think of, it would probably offer

the best performance.

• Samba (for using the RPi to share

a USB hard drive on the network).

STEP 4: DEBUGGING

I f, for some reason, your RPi

isn’t working properly, you have

two options:

• Connect a monitor, keyboard,

mouse and/or ethernet

connection.

• Use SSH or VNC to debug issues.

Naturally, the first option can

be difficult to achieve, depending

on where you are, and where the

RPi is set up. However, it is by far

the least complicated to actually

implement.

For option 2: It’s not going to

be an issue as long as your RPi is

actually connected to a network,

and you know the IP (if it isn’t on a

static IP you assigned, check your

router, as it may have picked up a

fallback DHCP IP). If you can find

the IP, then you shouldn’t have any

other issues connecting via SSH or

VNC.

If, however, the RPi isn’t

connected to the network

(because it’s a new wireless

network, for example), then you’ll

typically need to connect it via

ethernet, or use a monitor,

keyboard, and mouse to connect to

the new network. If you’re lazy and

want to make life easier for you -

you can simply set up a DHCP

server on your laptop (on both

Windows and Linux you’ll need to

install and set up some form of

DHCP server, but OS X offers that

option by default under System

Preferences -> Sharing -> Internet

Sharing). After the DHCP server is

running, you can just connect an

ethernet cable to the RPi from

your laptop, and then start the RPi

(it may work on an already running

system, but I have tested it only

from an off state). From your

laptop, you should be able to get a

list of clients and their IPs - this

depends on the server and OS

you’re using. Once you get the IP

of the client, you can just connect

via SSH or VNC, and work from

there.

That about wraps it up for this

month. If you have any issues, or

questions, feel free to email me at

lswest34+fcm@gmail.com. The

same is true for anyone who has

suggestions or requests for

articles - ideas are always

welcome!
EXTRA! EXTRA!
READ ALL ABOUT IT!

Our glorious news reporter

(Arnfried) is posting regular

news updates to the main Full

Circle site.

Click the NEWS link, in the site

menu at the top of the page,

and you'll see the news

headlines.

Alternatively, look on the right

side of any page on the site,

and you'll see the five latest

news posts.

Feel free to discuss the news

items. It's maybe something

that can spill back from the site

into the magazine. Enjoy!

mailto:lswest34@gmail.com
http://stackoverflow.com/questions/431684/how-do-i-cd-in-python/24176022#24176022
mailto:lswest34+fcm@gmail.com
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Last month, I suggested you get

a number of parts and if you

were able to get them, I hope that

it didn’t cost you too much. If you

haven’t gotten them, then follow

along as best you can, and if there

is a particular project you want to

try, then get those components

that are needed. I ’m trying to do

this on as little cash outlay for

either you or me as possible.

Frequently, you can recycle many

of the items from older electronic

items; many can be found at a local

thrift store for pence on a pound.

(Hopefully I got that one right. We

say pennies on a dollar here, so at

least give me an “F” for effort…

ok?)

As I was laying last week,

waiting for some surgery, I was

thinking that if someone were to

come up to me and ask directly

why I ’m doing this, what my

answer would be. Before the

wonderful chemicals they pumped

into my body to make the process

less horrible, I realized that the

REAL reason is multi-part. First, is

to create excitement in “non-

programmers” when doing things

that seemingly could not be done

without a ton of training. Secondly,

is to show that the newer

technology, like the Raspberry Pi

and the Arduino, is not beyond the

ken of the “general joe” out there,

but that anyone can do things that

have real world applications (hence

the title of our series) . That having

been said, making LEDs blink is

only the same kind of project for

the hardware world as the “Hello

World” program is in the

programming realm. You have to

take small steps before you move

to the big race. Believe me, we will

be doing some amazing things with

all those little parts, whatsits and

thingamabobs.

This month, we will be using the

DHT1 1 Basic Temperature/

Humidity Sensor with our

Raspberry Pi. Next month, we will

be doing the same sort of thing

using the Dallas DS1 8B20

temperature sensor, and if there is

time and/or space, we’ll also talk

about the 1 6x2 LCD display. In a

few months, we’ll switch from the

Raspberry Pi to using the Arduino.

Don’t worry, none of the things we

are using now will go unused after

a single project. For example, once

we have a grasp of some of the

Arduino basics (which WILL involve

learning a small amount of ‘C’ like

programming (sorry about that)) ,

we’ll be writing programs in

Python on the RPi (or your local

computer) to control the Arduino.

The sensors we have learned about

in our RPi experiments will be re-

used when we learn about the

Arduino, and many will be

incorporated into some larger

projects. Very shortly, we will be

using DC Motors, Solenoids and

Stepper Motors in some really

basic projects, but we’ll use them

in larger projects, including

building a Computer Controlled

(RPi) Laser Engraver using a Laser

Diode recovered from an old DVD

Burner.

Enough about the future. Let’s

start with this month's project.

The DHT1 1 is the least

expensive sibling of a series of

temperature and humidity sensor

sets. The DHT1 1 has a temperature

range from 0⁰ to 50⁰ C with ±2⁰ C

accuracy (32⁰ to 1 22⁰ F, ±3.6⁰F) and

a humidity range from 20-90%RH

±5%. You can see that it’s not the

most accurate sensor on the

market; there is a DHT22 that is

more accurate and has a wider

range (-40⁰ to 80⁰ C temp range)

but about twice as expensive.

It’s a bit of a funny looking

thing. A blue rectangular plastic

box with holes in it and something

shiny inside it. It might come just

as a single sensor with 4 pins, or

already on a mini-circuit board with

3 or 4 pins. Either way, they are

basically the same. For now, we’ll

use the discrete component (the

one without the circuit board) for

the sake of the discussion, and I ’ll

address the differences as we go

along.

Whenever you want to work

with a new sensor, you should get

a spec sheet (data sheet). A simple

web search should turn up a

number of results. Try to get

something directly from the

manufacturer if at all possible. For

the DHT1 1 , a good place to get

one of the various data sheets
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available is

http://www.micropik.com/PDF/dht

1 1 .pdf. While this isn’t directly

from the manufacturer, it is from a

company that sells it, and has

“translated” the manufacturer’s

data into a 9-page PDF file.

You might already be asking,

why do I need this? There’s a bunch

of information that, unless you

have a PhD in Physics or

something, you’ll never need. Well,

that is true, but there is a lot of

information that IS relevant and

can potentially keep you from

blowing up either the sensor, the

controller, or your work bench. In

this case, we find that the DC

operating voltage is between 3 to

5 volts and it pulls about 0.5mA

during “normal” conditions

(section 6). We also find that this is

a rather slow device and that we

should not try to pull data more

than once per second. Basically

we’ll keep it around once every

five seconds in our testing

program, which is way more than

we’ll need in reality. Another thing:

if the cable that sends the data

from the sensor to the

microcontroller (our RPi) is less

than 20 meters, we should have

about a 5K ohm resistor between

the data line and the local power

supply (at the sensor) as a pull-up.

One last thing (I ’m going to stop

here, but there’s much more): Pin 1

is positive voltage, Pin 2 is the data

pin, and Pin 4 is the ground pin.

This gives us pretty much

everything we need to know to

safely connect this to our RPi.

Below is the wiring diagram for a

“raw” DHT1 1 sensor WITHOUT a

breakout board. If you have a

sensor with a breakout board, see

my discussion below the diagram.

Notice that I said earlier that a

5K resistor was needed as a pull-

up. If you are going to use 3.3 VDC

as a power source (RPi pin 1 ) , then

a 5K resistor works pretty well. If,

however, you are going to use 5

VDC as shown in the diagram, use a

1 0K resistor.

You can see that it’s fairly

simple, just three wires and a

resistor. For our simple project,

don’t try to make the wiring the

entire 20 meters though.

If you have a DHT1 1 on a

breakout board, you will likely have

only 3 output pins on it. I have two

sensors from different vendors,

and (go figure) both have a

different pinout. One is laid out

[Data] [Positive Voltage] [Ground]

and is marked “S -”. The other is

[Ground] [Data] [Positive Voltage]

and is marked as such. Hopefully,

yours has some sort of pinout

definition printed on it. If not, you

can use a multimeter to trace the

ground pin and voltage pin directly

from the sensor to the breakout

pin. You can usually guess that if

there are three output pins on the

breakout board and you know

ground and positive voltage, then

the other SHOULD be the data pin.

Now our program code.

For the sake of getting things

up and running quickly, we will be

http://www.micropik.com/PDF/dht11.pdf
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using some code provided by the

kind people at Adafruit.com – they

provide the library for working

with the DHT1 1 . (They found that

trying to run straight Python code

for the library causes some timing

issues, so the library is actually

written in ‘C’.) There are a number

of steps involved, so follow the

instructions carefully. I ’ve

paraphrased them so if something

doesn’t work, you can also find the

instructions at the Adafruit

website at

https://learn.adafruit.com/dht-

humidity-sensing-on-raspberry-pi-

with-gdocs-logging/software-

install-updated . Once everything

is done, you can run my modified

Python example presented at the

end of the instructions.

In your "/home/pi" directory,

run the following commands:

git clone
https://github.com/adafruit/A
dafruit_Python_DHT.git

cd Adafruit_Python_DHT

sudo apt-get update

sudo apt-get install build-
essential python-dev python-
openssl

Ignore any errors that state a

package is already installed.

Next, install the library by

running:

sudo python setup.py install

Once all that is done, you can

move on to our sample code.

Above is my modified sample

code “borrowed” from the Adafruit

sample code.

All of the above can basically be

boiled down to three lines of code.

The two import statements and

the assignment of the variable

‘sensor’ to the class code.

pin = 4
sleep(3)

Here we define that the sensor

is connected to GPIO pin 4 and

then we wait 3 seconds for things

to settle and be ready to work.

We use a simple loop (next

page, top right) to grab the values

for humidity and temp over and

over. I never got the knack of

relating Celsius to “real”

temperatures, so I convert it so

that I can understand it. If you

want Celsius, just comment out the

conversion line.

Now (next page, bottom right)

we check to see if we got realistic

values for both humidity and

temperature, then we display

them and sleep for 5 seconds.

I must admit, when I run the

program with one sensor, it gives

some rather wacky results for the

first two or three minutes, then

#!/usr/bin/python
# simpletest.py
#----------------------------------------------------
# Original code information copyright below.
# Copyright (c) 2014 Adafruit Industries
# Author: Tony DiCola
# Permission is hereby granted, free of charge, to any person obtaining a copy
# of this software and associated documentation files (the "Software"), to deal
# in the Software without restriction, including without limitation the rights
# to use, copy, modify, merge, publish, distribute, sublicense, and/or sell
# copies of the Software, and to permit persons to whom the Software is
# furnished to do so, subject to the following conditions:
# The above copyright notice and this permission notice shall be included in all
# copies or substantial portions of the Software.
# Code modifications by G.D. Walters for Full Circle Magazine
import Adafruit_DHT
from time import sleep
#----------------------------------------------------
# Sensor should be set to Adafruit_DHT.DHT11,
# Adafruit_DHT.DHT22, or Adafruit_DHT.AM2302.
#sensor = Adafruit_DHT.DHT22
#----------------------------------------------------
sensor = Adafruit_DHT.DHT11
#----------------------------------------------------
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settles down to values that I can

trust. The other sensor seems to

“lock in” faster, so I ’m just writing

it off to something in the first

sensor.

Well, that’s it for this month.

Remember, we’ll be using the

Dallas temp sensor next time, so

be ready.

Have a good time and I ’ll see

you next month.

#----------------------------------------------------
# Here we loop over and over getting and displaying the
data.
# Use <Ctrl><C> to break out.
#----------------------------------------------------
while 1:

# Try to grab a sensor reading. Use the read_retry
method which will retry up

# to 15 times to get a sensor reading (waiting 2
seconds between each retry).

humidity, temperature =
Adafruit_DHT.read_retry(sensor, pin)

# Comment out the next line to display Celsius
temperature = temperature * 9/5.0 + 32

The Ubuntu Podcast covers all

the latest news and issues facing

Ubuntu Linux users and Free

Software fans in general. The

show appeals to the newest user

and the oldest coder. Our

discussions cover the

development of Ubuntu but

aren’t overly technical. We are

lucky enough to have some

great guests on the show, telling

us first hand about the latest

exciting developments they are

working on, in a way that we can

all understand! We also talk

about the Ubuntu community

and what it gets up to.

The show is presented by

members of the UK’s Ubuntu

Linux community. Because it is

covered by the Ubuntu Code of

Conduct it is suitable for all.

The show is broadcast live every

fortnight on a Tuesday evening

(British time) and is available for

download the following day.

podcast.ubuntu-uk.org

http://www.thedesignatedgeek.net
http://podcast.ubuntu-uk.org/
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This is part 60. The big six-zero.

Five years worth of articles

about my favorite office suite. Due

to demands at work and ambitions

to take my writing in other

directions, this is also my last

article in this series. It has been a

privilege to write for you each

month and teach you about the

many things you can do in

LibreOffice. Believe me when I say

I have learned a great deal by

writing for you.

In the years writing about

LibreOffice, I have collected a lot

of helpful hints that were too

short to constitute an article of

their own. So, for this final hurrah, I

bring you 1 0 quick tips for using

LibreOffice.

1 . ICON SETS

You can customize LibreOffice

in ways that work best for you.

One of these customizations is the

icon sets used for the toolbars.

There are seven different icon sets

in the latest version 5: Breeze,

Galaxy, High Contrast, Oxygen, Sifr,

Tango, and Human. Human is the

default for Linux, and Tango is the

default for Windows. Personally, I

like Sifr. The flat black icons are

easy for me to sort through. The

colorful icons of the other sets are

distracting for me. You can set the

icon size and style at Tools >

Options > LibreOffice > View.

2. KEYBOARD SHORTCUTS

Keyboard shortcuts are a great

time saver. Instead of taking your

hands off the keyboard to grab the

mouse and do something, your

hands can just stay at the keyboard

and get the same results. Like any

office suite, LibreOffice has a full

basket of shortcuts. You can get a

list of shortcuts at Tools >

Customize. Select the Keyboard

tab. Scroll through the list to see

what is available for LibreOffice in

general, or for the program you

are currently working in. It is worth

your time get to know the

shortcuts and start using them.

Don't try to learn them all at once.

Take a block of them and get

familiar with them. Once you have



full circle magazine #1 09 23 contents ^

HOWTO - LIBREOFFICE

that group down, start in on the

next. In Tools > Customize, you can

create your own shortcuts. The

keys or key combinations in the list

that are not grayed out are the

ones that are available for

changing. I would steer clear of

those that already have

assignments, and look for ones

that don't. Select the category and

function from the two lists below

and click modify to assign that

function to the key or key

combination.

3. MOUSE ZOOM

After preaching about keeping

your hands off the mouse, my next

tip is about zooming using the

mouse. Most mice today have a

scroll wheel, and you can use the

scroll wheel to zoom in and out of

your document. LibreOffice allows

you to zoom from 20% (very small)

to 600% (huge). Press the CTRL

key while turning the scroll wheel

to zoom in and out. Zoom in (make

it bigger) by scrolling the wheel

forward (away from you), and

zoom out (make it smaller) by

scrolling the wheel back (toward

you). The amount of zoom is

controlled by your mouse settings.

4. CROP AN IMAGE

You can now crop an image

directly in LibreOffice. No more

opening GiMP or some other

image program just to crop an

image. To crop a selected image,

Format > Image > Crop. Or you can

click the icon on the Graphic

toolbar. The image is surrounded

by eight control handles. Crop the

image horizontally or vertically by

dragging the center handles in the

side and top/bottom edges.

Dragging the corner handles crops

both. Dragging while holding the

SHIFT key maintains the image’s

original aspect-ratio. After

cropping an image, you can resize

it and still maintain your crop. Crop

mode stops when you press ESC or

click anywhere outside the image.

5. QUICK CALCULATIONS IN

WRITER

Sometimes while writing a

document, you need to insert the

results of a calculation. You could

go to your computer's calculator

program, but that means getting

out of Writer to start another

program. Instead, use the Formula

toolbar built into Writer. View >

Toolbars > Formula or pressing the

F2 key brings up the Formula

toolbar. The bar works in the same

manner as the formula bar in Calc,

but you have a smaller set of

functions you can use. Click on the

fx button for a menu of the

available functions. Once you

finish, click the check button or

press the Enter key. The result of

the calculation will appear at the

last position of your cursor.

6. PLACEHOLDERS

Placeholders are useful in

templates and Auto Text. They are

special fields that act as temporary

text until the actual text or object

is inserted. For example, if you

were creating a template for a

contract, you wouldn't know the

names of the parties involved in

the contact while you are creating

the template. You can insert

placeholder fields in the template

– to be filled in later when the

template is used to create a

document.
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To create a placeholder, CTRL-

F2 to open the Fields dialog. Click

on the functions tab. Select

placeholder from the Type list, and

pick the placeholder type from the

Format list. You can pick from Text,

Table, Frame, Image, and Object. In

the Placeholder text box, enter the

text you want to stand-in for the

placeholder. For example, with the

Text format selected, you could

enter "your name" to create a

placeholder that reads <your

name>. The Reference is a help tag

that appears when you hover your

mouse over the placeholder. Click

Insert to enter the placeholder in

your document.

To replace a placeholder with

the actual information for the

document, click on the placeholder

and start typing for a text

placeholder. For the table, frame,

and object placeholders, you get

the appropriate dialog. For the

image placeholder, you get a file

dialog. The placeholder is replaced

with text you type or object you

set with the dialog.

7. PROTECTING SECTIONS IN

WRITER

You can protect any section of a

writer document from changes.

Some sections, like table of

contents, are protected by default.

If you were creating a template for

a legal document, and there were

parts of the document that should

never change, you can protect

them from changes with a

password. Select the text you need

to protect, then Insert > Section.

Give the section a name. Check the

Protect and Password check boxes.

A password dialog will pop up.

Enter and confirm the password.

Click OK. In the Section dialog,

click Insert.

To remove the protection and

make changes, Format > Sections.

Select the section you want to

change. Uncheck the Protect check

box, and enter the password when

prompted. You can now make

changes to the section.

8. ENTIRE ROW/COLUMN

REFERENCE

When creating a formula in

Calc, you sometimes need to

reference an entire row or column,

usually because the column or row

will grow and you have no way to

know where it will end. Before

version 5, you had to create a

reference like A1 :A1 048576 for

columns or A1 :AMJ1 for rows.

Now, you can use a short reference

to the column or row. For columns,

you can enter A:A to reference the

entire A column. For rows you can

enter 1 :1 to reference the entire

row 1 . You can even reference a

range of columns or rows (A:B,

1 :2) .

9. AUTO FILTERS TOP 1 0

Calc allows you to easily show

the top 1 0 values in any column

through the AutoFilter function. To

activate the filter, Data > Filter >

AutoFilter. Once active, the filter

shows a down arrow in the first cell

of each column. Clicking on the

arrow opens a drop down menu.

One of the options is Top 1 0.

Select Top 1 0 and you will get the

top 1 0 records based on the values

in that column. You could use it to

determine your highest sales day,

or the day of the highest peak on a

stock. This tip works only for

columnar data. To clear the
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AutoFilter, select Data > Filter >

AutoFilter again.

1 0. SCIENTIFIC FORMAT AND

ENGINEER NOTATION

Scientific notation is used to

express very large or very small

numbers. The basic idea is to take a

predetermined number of digits

and multiply them by powers of 1 0.

This allows scientists and

engineers to express these large

numbers without having to write

out all the digits. Engineer

notation is a subset of scientific

notation where the powers of 1 0

are a multiple of 3.

Calc will allow you to express

both of these. Let's take the rather

large number 1 2455485785256. A

rather large number to type over

and over again. In Calc, we can

convert this number to scientific

notation. Format > Cells. On the

Numbers tab select Scientific from

the Category list box. Click OK. Our

number is transformed into Calc's

version of scientific notation,

1 .25E+1 3. 1 .25 is the significant

digits, E is the place holder for 1 0,

and +1 3 represents the exponent

of 1 0. If we want engineer

notation, Format > Cells. Again,

with Scientific selected, check the

"Engineering notation" check box.

Our number in engineering

notation becomes 1 2.46E+1 2. Note

that the exponent is now a

multiple of 3.

ONE LAST THING

I 'd like to share one last thing

with you that has been a big help

to me while writing 60 articles

about LibreOffice –

documentation. I have a few

helpful links to share with you.

Each one provides something

different.

The LibreOffice Community

Support Page:

http://www.libreoffice.org/get-

help/community-support/

The Community Support Page

has links to documentation, online

help, Ask LibreOffice, IRC, the wiki,

and mailing list. You will want to

check the document page often to

see what manuals have been

updated.

LibreOffice Documentation /

Publication Page:

https://wiki.documentfoundation.

org/Documentation/Publications

If you can't wait for the official

release of a manual, this is the

page where you find the

documentation team’s drafts. Keep

in mind that many of these

documents are drafts and may

contain mistakes and errors. When

I was writing about Base, this was

one of the only places to find

documentation at the time. Of

course, now there is an official

Base manual. Just my luck.

Document Foundation Blog:

https://blog.documentfoundation.

org/

The Document Foundation blog

is a great place to get news about

new releases, tips, events, and

more. They don't overwhelm you

with posts, but they do keep you

up to date.

With that, we come to the

conclusion of my series on

LibreOffice. It has been a great joy,

and I wish many more successful

years of publication for Full Circle. I

will continue as a reader, and you

may still see an article from me

now and then, just not every

month.

I leave you with one final

thought, "Don'twork so hardthat

you don't take time to live, anddon't

live so hardthatyou can't enjoy

work."

http://eeperry.wordpress.com
http://www.libreoffice.org/get-help/community-support/
https://wiki.documentfoundation.org/Documentation/Publications
https://blog.documentfoundation.org/
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In the early days of computers, a

company called Digital Equipment

Corporation (DEC) created its 32-

bit VAX computer using openVMS

as its operating system. Because a

VAX/VMS computer is so reliable,

there are today - after more than

25 years - still a large number of

them in use. But, in the end, even

these reliable computers will have

to be replaced. As described in

part 1 , you could migrate from

VAX/VMS to Linux, as the way

Linux works is largely compatible

with VAX/VMS. If you use Pascal as

your programming language, you

will find that Lazarus/Free Pascal is

a good replacement. But there are

technical functions used in VMS

with no apparent replacement in

Linux. In this article I will describe

the terminal interface DCL and

ASTs.

DCL

When you log on to a Linux

system (or start the terminal) , a

program is started to prompt you

for commands. This is called the

shell, and in my case this program

is Bash. When you log on to a VMS

system, the same happens. On

VMS, this program is called DCL

(Digital Command Language).

For the user, it looks like there

is no difference, but the way these

programs work is quite different.

As mentioned in part 3, there is

one big difference: DCL is a real

shell, it wraps around a process

and every time an executable

(“image” in VMS) is started, it runs

within this shell, within the same

memory, with the same logicals

and symbols (environment

variables) , and with the same

process ID. Bash is called a shell,

but it is NOT! It is a CLI (Command

Line Interpreter) . Every time an

executable is started in Linux, it's

started in a new subprocess with a

different PID.

Another difference is the use of

the “$”-character. In VMS, it has no

meaning and is frequently used in

names of logicals (like

SYS$SYSTEM), system calls (like

$QIOW) and internal DCL functions

(like F$ELEMENT). In Bash, it

denotes the translation of

variables, even if in between

double quotes. This - and the fact

that Free Pascal has a similar

problem - is the reason why the

migration tool replaces the dollar

with an underscore.

DCL has a powerful set of built-

in commands and functions. These

are so versatile that entire

programs have been written in DCL

functions. When you migrate a

VMS system to Linux, you will have

to include these “programs”. The

functions of bash to replace the

functions of DCL are so different in

syntax and working, that the

migration of DCL “programs” is a

lot of work and some will simply

fail to migrate as there might be

no substitution for one or more

DCL functions. An example - to

read a file is shown below.

In DCL every line must start

with a “$”, or it will not see it as a

command.

In Linux, the first parameter on

a command-line is denoted as 1 ,

while the same parameter in VMS

is denoted as P1 . The translation of

a variable in Linux is done by

prefixing with a $; in VMS by

enclosing in single quotes, hence

$1 in Linux is 'P1 ' in VMS. “echo”

writes a line to the terminal in

Linux; in VMS, “write sys$output” is

used. “sys$output” is a process-

logical (for explanation of logicals

see part 3) , so, by redefining

Bash:
while read a_line
do

echo $a_line
done < $1

DCL:
$ open/read 'P1' file_var
$loop:
$ read/end_of_file=done file_var a_line
$ write sys$output 'a_line'
$ goto loop
$done:
$ close file_var
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“sys$output”, you can influence

where the output is going.

“file_var” in the above example

is also a logical. As a consequence,

this means that, if the file is not

closed, it will still be open if the

same script (command file) is

executed again in the same

session. That might be intentional

if two scripts have to be executed

consecutively, but it's usually a big

problem when a script crashes and

you start it again after fixing the

problem. Then the file is still open

and continues from the point

where the script crashed, giving

unexpected results. In this case,

after a crash, you have to close the

file manually by deleting the

logical.

I cannot imagine how a

migration tool would be able to

create a working bash script from a

DCL script (in VMS this is called a

command-file, default file type is

.COM). So I started working on the

creation of a DCL clone. It will be

able to process DCL command-files

while accepting commands from

the command-line using DCL

syntax. An example: To get the list

and translation of the group

logicals in Linux, I must execute

the case-sensitive command:

/VMS/show log -g “*” .

My DCL program will accept the

standard case-insensitive

command:

show log /group * .

This way, every existing DCL

“program” will behave the same

with only small adaptations.

ASTS

In VMS, all communication with

the terminal goes through the

driver “TTDRV”. When the user

gives a special command using

control characters (mostly ^C, ^Y,

^T and ^Z), the driver will issue an

AST (Asynchronous System Trap).

Essentially, an AST is a system

callback routine. As it is unknown

when this callback routine is called,

you must take special precautions.

In VAX-pascal you signal this to the

compiler through the attribute

“[ASYNCHRONOUS]” for the

procedure that is called, and the

attribute “[VOLATILE]” for any

variable accessed from within this

procedure. The attribute

“[VOLATILE]” prevents the

compiler from doing any

optimization that would make the

variable inaccessible, like using a

CPU register for it. ASTs can be

compared to signal catching in

Linux.

The best equivalent of these

ASTs is the use of the method

“Synchronize” of the class

“tthread”. To get the same

behavior as in VMS, the DCL

process is used to process all input

from the terminal and output to

the terminal. The DCL process

communicates through pipes with

a separate thread created at

program start using the class

“tthread”. When the user presses

any of the special control

characters, this thread will call a

dedicated procedure - defined in

the class, but executed in the main

thread - using “Synchronize”. On

^C, the process will terminate; on

^Y, the main thread will be

suspended; on ^T, status

information will be sent to the

terminal (if specified in the main

thread), and on ^Z, a controlled

termination will take place. When

the main thread is suspended after

^Y, two things can happen:

• If “continue” is typed in the DCL

process, the main thread will be

resumed.

• If a new command is given,

resulting in the start of another

process, the suspended process

will be terminated.

To get this behavior, DCL must

be aware of the control characters

and act upon them.

Something like the attribute

“[VOLATILE]” is not necessary as I

have not seen Free Pascal doing

any optimization (unfortunately) .

On activation of a QIO(W) (see

part 2) or timer, it is also possible

to specify an AST to be called on

termination. These are

implemented the same way, as

both work through the creation of

a new thread.

DETACHED PROCESS:

I f you start a detached process

(a process without a parent) in

VMS, it is started without DCL as a

shell. Some programs depend on

the existence of DCL - if they call

an internal function. To run such a

program, you must create a

command-file stating: “$run

program_name”, and start DCL as a

detached process with this

command file as input. This proves

that DCL itself is just a program

which is called “LOGINOUT.EXE” .
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The most common use of this is

to execute a script (command-file)

as a detached program, for

example once a day to clean up,

back up, or trigger an event.

NEXT MONTH

In the next article I will go more

in depth about the network

database DBMS32 and its

(dis)advantages.

THE OFFICIAL FULL CIRCLE APP FOR UBUNTU TOUCH

B rian Douglass has created a

fantastic app for Ubuntu Touch

devices that will allow you to view

current issues, and back issues, and

to download and view them on your

Ubuntu Touch phone/tablet.

INSTALL

Either search for 'full circle' in the

Ubuntu Touch store and click

install, or view the URL below on

your device and click install to be

taken to the store page.

https://uappexplorer.com/app/

fullcircle.bhdouglass

mailto:info@theovanoosten.nl
https://uappexplorer.com/app/fullcircle.bhdouglass
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Since starting the Full Circle

Weekly News

(http://fullcirclemagazine.org/pod

cast) , I ’ve had to learn the basics of

Audacity. Thankfully, since the

podcast is short and pretty simple

to put together, I only really need

to use the absolute bare basics of

Audacity.

IN THE BEGINNING

While Audacity might look

somewhat imposing. Don’t worry.

We’ll be using only a handful of the

items in its arsenal.

The first thing you’ll want to do

(assuming you have a microphone

plugged in) is click the microphone

icon (below the menu) and select

‘Start Monitoring’.

If your microphone is on and

ready to begin recording, you

should see a horizontal green bar

flickering as the sound levels rise

and fall.

NOTE: For the Full Circle Weekly

News, I ’m not going for high

quality output. Hence, you’ll see

me using mono audio and low

output settings. I ’m trying to keep

the final file size to an absolute

minimum.

If you have a microphone

plugged in, but nothing showing in

the monitoring step, then you’ll

want to go to Edit > Preferences

(in the menu) and in that window,

select Devices. That’s where you

select your playback and recording

devices.

TESTING TESTING

So, time to test things out. The

main feature at the top of the

Audacity window is the all-too-

familiar controls such as pause,

play, stop, etc.

When you’re ready, click

the record button

(shown left, the one with

the big red dot on it) , and pause

for a second or two before

speaking. Why? I ’ll show you

shortly.

Ok, now do your

speaking. Press the stop

button (shown left,
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square icon) to, well, stop

recording.

You should now see a waveform

of your speech (previous page,

bottom right) .

Pressing the play button

(shown left, green

triangle) will play back

the speech you recorded.

What’s that? You had to turn

the speakers up to hear it? OK,

let’s clean this up a bit and

increase the volume on it.

NOISE REDUCTION

First, click the

‘Selection Tool’

(shown left, a

vertical bar)

from beside the

record button. To zoom in/out of

your waveform you can click the

magnifying glass icons. What we

want to do is select the empty

portion of the waveform. That first

second, or two. Click and drag at

the start of the waveform to just

where the waveform becomes

taller. Like I ’ve done in the

screenshot.

Now, in the menu, choose

Effect > Noise Reduction. In the

popup that appears, click the ‘Get

Noise Profile’ button.

The window will close.

What we’ve done here is tell

Audacity that the selected area is

background noise.

Now click the area to the left of

the waveform – just above the

small ‘Mute’ and ‘Solo’ buttons.

This will select the entire

waveform for you. Nifty!

In the menu, again, click Effect

> Noise Reduction, but this time

just click OK. The rest of the

settings are set for us from the last

step.

It’ll probably be small, but you’ll

see a change in your waveform.

Here’s mine before and after:

It’s not much, but it’s cleaned

up the waveform.

AMPLIFICATION

Now, in the menu, choose

Effect > Amplify. This effect will

amplify the waveform to make it

louder. Where it says ‘Allow

clipping’ should be unchecked. If

this is checked then it will mean

the amplification could be

excessive and it might distort your

audio – making it sound bad. The

amplification setting that Audacity

has chosen for this waveform is

1 0.36. I ’ll go with that (by clicking

OK).

You can see that one of the

spikes is just touching the bottom

edge of the preview window.

That’s clipping. If I ’d checked the

box I could up the dB setting, but it

would take the waveform out of

the range and possibly cause

distortion.

I could just as easily click Edit >

Undo, select my waveform, do

Effects > Amplify again and up the
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dB to try it out. Audacity is pretty

good with its undo feature.

OK. I have my waveform

cleaned, and amplified. Now I can

select the blank space (as we did

before) and press the delete key to

remove it. Same at the trailing end

of the waveform.

Now it’s time to save your

masterpiece.

SAVING AUDIO

In the menu, click File > Export

Audio. In this window you choose

the file name, file format, and

some quality settings. Like I

mentioned earlier, with the

podcast I go for low quality and a

small file size, so I usually go with a

1 28Kbps MP3 file.

SAVING PROJECT

Select the entire waveform

again and, in the menu, do Edit >

Duplicate. If you play the audio

you’ll get a slightly louder sound.

But click the

‘Time Shift Tool’

(shown left) and

drag the bottom

waveform to the

right slightly. Now click Play.

Spooky!

But with the move tool you can

also drag the waveform up. You

can close the now empty track by

clicking the X at the top left of the

track. Now you’ll get the same

thing twice.

Pretty useless, but this shows

you how to drag and drop

waveforms within Audacity.

The whole point of this exercise

is to show that there is a File >

Save Project option too. That

doesn’t save an audio file. That

saves an AUP file which is your

Audacity project. This means you

can reload your layout and

continue editing later.

MORE?

Audacity can do a million other

things, but I never use them. The

things I ’ve shown you above are

enough for me to create a quick

podcast.

If you’d like to see more about

Audacity do let me know. For

another part, I could show you how

to use the Envelope Tool to create

nicely controlled fade in/out

effects that I use in the podcast

intro (shown below).

If you’ve any Audacity tricks

you’d like to share, feel free to

email them to me, Ronnie, at:

ronnie@fullcirclemagazine.org

Ronnie is the founder and (still! )
editor of Full Circle. He's a part-time
arts and crafts sort of guy, and now
an Arduino tinkerer.

mailto:ronnie@fullcirclemagazine.org
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Last time, I introduced the Filter

Editor dialog and

demonstrated how to create a

simple filter chain, resulting in a

drop shadow effect. The chain

consisted of three filter primitives:

Gaussian Blur, Offset and Merge. I

also used the Source Alpha and

Source Graphic inputs. Recall that

each primitive in the chain has one

or more inputs, denoted by

triangles, and a single output

represented by the bottom of the

primitive. The output from the

chain as a whole is always the

output from the last primitive.

Therefore, in the Inkscape UI , our

drop shadow chain looks like that

shown below left

With a simple chain this is fairly

understandable but, as the

complexity of your filters grows, a

simple one-dimensional list

becomes an unwieldy tool for

looking at the complex

arrangement of primitives that

evolves. Mathematically speaking,

filters are a “directed graph”,

consisting of a series of nodes (the

primitives) and uni-directional lines

connecting them. Such graphs are

usually drawn in two dimensions,

and you may find it easier to try to

imagine your chains in that form.

For example, our simple drop

shadow could be represented like

that shown below right.

Here I 've used blue boxes for

the primitives, green for the image

sources, and teal for the final

output. The gray box just shows

the intermediate result that you

would see if you could peek into

the filter chain at that point.

Hopefully you can see how this

layout relates to the Inkscape UI ,

and I 'll use this approach again to

describe more complex filters as

the series goes on.

One problem with our drop

shadow is that it's based on the

Source Alpha of the original object,

which is essentially a black

silhouette. But what if you want

your shadow to be more

translucent – gray rather than

black – or you want it to have a

different color entirely? There is a

filter primitive that lets us

manipulate the color of the image

in the chain, but unfortunately it's

another case of a confusing UI that

could have been made a lot more

obvious.

Start by adding the Color Matrix

primitive to your filter. It will

appear at the bottom of the chain,

but you can drag it to another
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location. We'll start by changing

the opacity of the shadow, so it

either needs to go after the

Gaussian Blur step (to change the

opacity of the already blurred

image), or right at the top of the

chain (to change the opacity

before the blur is applied). Either

approach will give roughly the

same result, so I 've chosen to put it

at the top of the list. You then

need to modify the connections so

that the Color Matrix gets its input

from the Source Alpha column, and

the Gaussian Blur gets its input

from the Color Matrix primitive.

With the Color Matrix primitive

selected, take a look at the

parameters at the bottom of the

dialog. First there is a Type pop-up

which lets you select between four

different varieties of color

manipulation. Three of them have

simple, easy-to-use interfaces… so

of course we need the other one!

Select the Matrix option (this is

also the default when you first add

the primitive) , and you'll be

presented with a grid of numbers

with little extra explanation (there

is a lengthy tooltip, but I 'm not

sure it helps very much).

Above is that same matrix,

presented with some headings to

help clarify things:

Remember that filters are a way

to manipulate the bitmap version

of your vector image, just at the

point it's converted to pixels. This

matrix essentially holds some rules

about how each individual pixel in

your input image should be

modified in order to produce the

corresponding pixel in your output

image.

Let's take the top row as an

example. Suppose the first pixel in

our image has an RGB value of

(1 50, 1 28, 255) and it's completely

opaque (an Alpha value of 255). To

calculate the color of the output

pixel we have to calculate its R, G,

B and A values separately – the top

row, therefore, is only concerned

with the Red component of the

pixel. The formula for calculating

the Red output pixel value is:

ROUT = (RIN × 1 .00) + (GIN ×

0.00) + (BIN × 0.00) + (AIN × 0.00) +

(255 × 0.00)

The bold numbers in the

formula are taken from the first

row of figures in the matrix. Clearly

only the first value has an effect in

this case, as all the others are zero,

so ROUT is simply the same as RIN

× 1 .00. In other words, with these

figures the red component is

passed through untouched, with a

value of 1 50. If you repeat the

process for each of the remaining

three lines, you'll see that the

default color matrix simply passes

the input color through to the

output without modifying it. It's an

“identity” matrix, in mathematical

terms. Because the same matrix is

used for every pixel in the input

image, the result is that this filter

primitive will just copy the input

image directly to the output

without changing it at all.
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To make the drop-shadow more

translucent, we need to modify the

output Alpha value. On the bottom

row of the matrix, click on the 1 .00

field and change it to 0.50 then

press the Return or Enter key.

Immediately you'll see the drop

shadow change. You can choose

any value you wish (between 0.00

and 1 .00) in order to create a

lighter or darker shadow.

What about changing the color

of the shadow? There are a few

ways to go about this, but we'll

start by using the fourth column in

the Color Matrix – the one labelled

as “Fixed Offset” in my diagram.

Consider that the black pixels in

the Source Alpha image have an

RGBA value of (0, 0, 0, 1 ) – with all

those zeros it's clear that no

amount of multiplication will

change the output of the red,

green and blue components. But

the fourth column lets us add (or

subtract) a fixed value. If you

change the fourth column on the

third row to 0.80, the formula for

the blue component of the output

pixels becomes:

BOUT = (RIN × 0.00) + (GIN ×

0.00) + (BIN × 1 .00) + (AIN × 0.00) +

(255 × 0.80)

The multiplied R, G and B values

all come to 0, but then we add 255

× 0.8 onto the result, giving us a

final blue component of 204. Our

RGBA output value therefore

becomes (0, 0, 204, 1 ) , giving us a

blue drop shadow. Try changing

the values of the fixed offset for R

and G as well and you'll quickly see

that we can use this technique to

produce any color of shadow we

want, all from our black silhouette.

How about using the Color

Matrix filter to go in the opposite

direction – to generate a black

shadow from a colored one? No

problem, but first you'll need a

colored image to work with. The

easiest option is to move the input

connection from Source Alpha to

Source Graphic. You should also

change your Color Matrix values

back to the identity matrix to give

you a known state to start from.

With that done, your drop shadow

should now be the same color as

your original object (red, in my

case).

To convert our color to black,

we have to set each component to

zero. There are a couple of ways to

do this:

• Put -1 .00 into the Fixed Offset

field for the R, G and B output

values. No matter what the input

values are, this has the effect of

subtracting 255 from the output.

This has the effect of setting each

output to zero, because it's not

possible for a color component to

go any lower than that.

• Change the 1 .00 values in the first

three rows to 0.00 instead.

Regardless of the input value,

multiplying it by zero will give a

zero output.

I took the second approach, to

give me a black drop shadow once

more:

Of course this is a terribly

inefficient way to create a

silhouette compared with just

linking to the Background Alpha

source, but it helps to demonstrate

how output values are calculated

from input values. So far, however,

we've just looked at simple

mappings, where red remains red

and blue remains blue, but this

filter primitive also allows you to

map one input component to a

completely different output.

Consider a matrix like this:
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I t's similar to the identity

matrix, except that the R, G and B

columns are shifted by one place.

The result is that the red

component of the output pixel is

taken from the value of the green

component of the input, whilst the

green output comes from the blue

input and the blue output is taken

from the red input. Let's see the

result on a multi-colored source

image:

Notice that this moves away

from having a simple fixed color

for the shadow, and instead

produces different colors based on

the corresponding pixel in the

input image. If you include the

output Alpha channel, things can

get even weirder. Here's our multi-

colored text with the RGB values

zeroed to give us a black drop

shadow again, except that the

fourth row has been changed so

that the Alpha channel is taken

from the Red input component.

Notice that colors with a high red

value have dense, solid shadows,

whilst those with no red in them

(such as the green S and blue O in

“Shadow”) have no shadows at all.

Although I 've shown only

relatively simple examples here,

it's possible to create complex

mappings between color channels.

If you really want your red output

to consist of 90% of the red input,

less 1 0% of the green, less 35% of

the blue, plus a fixed offset of 64,

you just have to put values of 0.9,

-0.1 , -0.35 and 0.25 into the top

row. Of course, predicting the

output from complex combinations

like this becomes rather difficult,

so for normal use I recommend

sticking with simpler, easy to

understand mappings.

This ability to flexibly map color

components to each other, or to

and from the Alpha value, can be

useful on some complex and

esoteric filters. Most of the time,

however, you don't need that

degree of flexibility, so the Type

pop-up provides three other

options to avoid you having to

wrestle with the full matrix:

• Saturate: Provides a slider to let

you change the saturation of your

image. In other words, remove

color from it, ultimately producing

a grayscale result at the most

extreme.

• Hue Rotate: Shift the color of

your object by a fixed amount.

• Luminance to Alpha : Set the

output alpha based on the RGB

input values. In theory this makes

dark areas more transparent and

light areas more opaque, but RGB

doesn't map neatly to the human

perception of brightness, so this

really works effectively only on

grayscale input images. This can be

used to punch holes in your filter

output, based on the images

produced in other parts of the

chain.

Notable by its absence is a

shorthand option for adjusting the

opacity – where we came in at the

start of this article. Unfortunately,

if you want to make your drop

shadow a little more transparent,

you have no choice but to deal with

the full matrix approach, even if

you are only changing a single

value in the bottom row.

http://www.peppertop.com
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Awhile ago I backed a

Kickstarter project called

Arduboy. Well, many months later,

it has come to fruition and I finally

have one of these incredibly small

units.

Think of a marriage between a

Nintendo Gameboy and an

Arduino. That offspring would be

the Arduboy. Measuring just 53mm

x 85mm x 5mm, and weighing just

1 4 grams, it easily fits into the

palm of your hand.

Internally it uses an AT

MEGA32U4 with an SSD 1 306 OLED

screen. Here are some other specs:

• Total Flash Memory: 32kb

• RAM: 2.5kb

• EEPROM: 1 kb

• Frequency: 1 6mhz

• Monochrome Display: OLED

• Horizontal Pixels: 1 28

• Vertical Pixels: 64

• Lithium Polymer Battery: 1 80mAh

• Piezo Speaker: 1

The Arduboy comes with one

game pre-installed (a Tetris clone)

but there are many online games

that can be uploaded to the unit.

Uploading games is something I

haven’t tried yet, but I ’ll try and

cover that next month as I think it

is done by uploading the actual

code, ala Arduino IDE, but I ’ll

double check on that first.

https://www.arduboy.com/

Price: $39

https://www.arduboy.com/
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Written by S. J. Webb
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Over the course of the last

year, I wrote exclusively

about the Chrome OS.

Consequently I became interested

in the cloud. Future articles will be

on cloud focused products,

Chrome OS, and random thoughts

of a Linux lunatic. This month I will

review one cloud based item.

One item that touches the

cloud is the Amazon Tap. Some

reviewers consider it to be the real

life version of a personal assistant.

This is the vehicle for Amazon’s

virtual assistant named Alexa.

Alexa is Amazon’s answer to

Cortana and Siri. Alexa can be

found in an app—similar to

Amazon Echo and Amazon Echo

Dot. The Tap is a middle-of-road

option. The Echo and Echo Dot are

always active to answer your

commands or questions. The Tap is

not and requires a touch button to

use it (see photos). Therefore the

Tap has a longer battery life, since

it is not always active.

I purchased the Tap directly

from Amazon. The item was

backordered for three weeks. It

arrived in a simple black box with

simple instructions. The Tap needs

to be fully charged. I then

downloaded the Alexa App to my

iPhone. Using an iPhone, I

connected to the Tap. After that

successful connection, I tied the

Tap into my Wifi. The Tap is tied to

my Amazon Prime account.

I can ask basic questions, and

listen to books, or music. The

sound quality from the Tap is fine

for the average owner. There is a

learning curve to Alexa. You must

learn how to give commands

correctly to maximize Alexa’s

usefulness. Simply stating

“Ramones, I wanna be Sedated,”

does not work. You need to say “I

want to hear I wanna be Sedated

by the Ramones.” Alexa will then

query Amazon and start playing

the song.

Alexa has a learning AI . She

eventually recognizes your voice

and preferences. Additionally, the

Alexa App on my iPhone checks if

my requests and fulfillment are

done correctly. Alexa lists these as

cards. These cards are a part of the

learning AI protocol developed by

Amazon. To maximize Alexa, I have

to interact with the iPhone App.

There are numerous cloud

products to simplify our lives,

which are unnecessary—Rocket

Book One is such an example. It is a

well made notebook, that is quite

sturdy. However it is a notebook

that uses QR codes, an app, and

the camera on your smartphone.

From these three elements, you

can write your notes, take a

picture, and it will label the page

via QR code to reside on the cloud.

Thus, I can have instant access to

my notes on my iPhone. While it

sounds magical, it is something I

can already do with my iCloud

account or Google Photos.
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GUIDELINES

The single rule for an article is

that it must somehow be

linked to Ubuntu or one of the

many derivatives of Ubuntu

(Kubuntu, Xubuntu, Lubuntu, etc).

RULES

• There is no word limit for articles,

but be advised that long articles

may be split across several issues.

• For advice, please refer to the

Official Full Circle Style Guide:

http://url.fullcirclemagazine.org/7

5d471

• Write your article in whichever

software you choose, I would

recommend LibreOffice, but most

importantly - PLEASE SPELL AND

GRAMMAR CHECK IT!

• In your article, please indicate

where you would like a particular

image to be placed by indicating

the image name in a new

paragraph or by embedding the

image in the ODT (Open Office)

document.

• Images should be JPG, no wider

than 800 pixels, and use low

compression.

• Do not use tables or any type of

bold or italic formatting.

If you are writing a review,

please follow these guidelines :

When you are ready to submit

your article please email it to:

articles@fullcirclemagazine.org

TRANSLATIONS

I f you would like to translate

Full Circle into your native

language please send an email to

ronnie@fullcirclemagazine.org and

we will either put you in touch with

an existing team, or give you

access to the raw text to translate

from. With a completed PDF, you

will be able to upload your file to

the main Full Circle site.

REVIEWS

GAMES/APPLICATIONS
When reviewing games/applications please state clearly:

• title of the game

• who makes the game

• is it free, or a paid download?

• where to get it from (give download/homepage URL)

• is it Linux native, or did you use Wine?

• your marks out of five

• a summary with positive and negative points

HARDWARE
When reviewing hardware please state clearly:

• make and model of the hardware

• what category would you put this hardware into?

• any glitches that you may have had while using the hardware?

• easy to get the hardware working in Linux?

• did you have to use Windows drivers?

• marks out of five

• a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.

http://url.fullcirclemagazine.org/75d471
mailto:articles@fullcirclemagazine.org
mailto:ronnie@fullcirclemagazine.org
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With 1 6.04 Xenial Xerus, all

versions of our *Ubuntu

distributions are Long-Term

Support (LTS). So, now seems a

good time to cast a glance at what

hardware is still capable of running

them. People with aging

computers may be on the fence on

whether to stay with 1 4.04 -- still

to be supported up until April of

201 9 -- or to switch to a newer

version. Better support for newer

pieces of hardware (graphics cards,

Bluetooth and whatnot) may not

be of interest for users of older

machines, but keeping an old but

still working machine in business

may well be.

The first piece of advice will

naturally be: “If it ain’t broke, don’t

fix it”, meaning that if you are

happy with your computer the way

it is, there is no immediate hurry to

change versions. Just keep it up to

date, and you will mostly be fine.

With that out of the way, what

about those who like to have the

newest and greatest, while still

running what would in some circles

be considered “legacy” computers?

Netbooks are a breed that can still

be of use thanks to their low

weight and general ease of

transport. Unfortunately, not many

are offered new these days, being

replaced by tablets and

Chromebooks. I have nothing

against such, but there are

situations in which a good old VGA

output or an Ethernet port can be

of use… So putting an old netbook

back into use as a nomad's

computer can make sense in more

ways than one (money being,

naturally, a consideration as well) .

However, not all netbooks are

still quite up to the task. For

example, the Asus eeePC can no

longer handle a standard Ubuntu

installation inside its puny 4 GByte

internal drive. Older netbooks

using the PC2700 memory

modules may also be out of luck,

since it may be difficult to find a

combination of memory modules

capable of getting a reasonable

total amount of RAM. Most

modules were, like these, of only

256 MByte capacity, and there

used to be a maximum of two

memory slots available in most
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laptops.

For a reasonable minimum

hardware starting point, perhaps

an Intel Core Duo or Atom dual-

core CPU with 1 GByte of RAM can

be considered a bare minimum,

below which the resulting system

may very well be convinced to run,

but no longer give a good user

experience when actually working

with it. To set an example, I will be

using an Acer Aspire One (D250)

from back in 2009. This particular

computer has an Atom N2600 1 .6

GHz CPU, 1 GByte of DDR3 RAM, a

1 0" screen with 1 024x600

resolution, and supports internal

2.5” hard drives though a SATA-I

compatible (1 .5 Gb/s) connection.

It also has a WiFi card, but no CD or

DVD. It originally came with some

version of Windows 7 (Windows

Home, perhaps) though the sticker

on the bottom is completely faded

and I cannot be bothered to

remember. In any case, it has run

several versions of Ubuntu over

the years, from 1 0.04 on up to the

latest Linux Mint 1 7.3 MATE based

on Ubuntu 1 4.04. But can it still

perform under 1 6.04?

Since 1 6.04 had not yet been

officially released at the time of

writing, I used the Beta 2 releases

for Ubuntu and Ubuntu-MATE for

this test. Naturally, the i386 (32-

bit) architecture versions were

chosen, as indeed they must be on

most netbooks. 64-bit CPUs came

late to these laptops compared to

desktops or high-end laptops, and

little can be found before AMD

came into the market in later

Aspire Ones, with an 1 1 " screen.

Actually, the Acer does work

quite well under Ubuntu 1 6.04 -

yes, even under Ubuntu itself with

the Unity desktop manager. I am

typing this right now on Google

Drive running the Live CD and

Firefox. There is a noticeable lag

between hitting the keys and

getting text to actually appear on

screen -- especially when one of

the images occupies some real

estate on-screen -- but actual work

can happen. It is in fact less

annoying than a second computer

on my desk at this particular time,

which has Windows 8.1 getting

purged of the various pieces of

useless software the manufacturer

stuck on it from new, and which

now has the hard drive rumbling

along, pegged at 1 00% usage.

There are no hard drive noises

from the Acer, which is running

along nicely just from RAM.

There have been some

annoyances along the way, though.

The main one on this computer

was the insistence of the system to

continuously go to sleep - every 1 0

seconds or so. This seems to be a

bug that came with systemd. Not

that I wish to bash upon systemd,

but several bugs have appeared

because of it over the months. In

this case, a solution is easy to

implement by opening a terminal,

getting root access and editing file

/etc/systemd/logind.conf:

ubuntu@ubuntu:~$ sudo bash

root@ubuntu:~# editor
/etc/systemd/logind.conf

Two lines need to be added,

that basically tell the power

management system not to sleep

if the lid closed sensor is triggered.

There is no need to take any

account of this sensor, basically

because this computer does not

have one! Anyhow, this is clearly an

issue with this particular model,

and should not happen with other

makes or models. The two lines

are:

HandleSuspendKey=ignore

HandleLidSwitch=ignore

Once done, we will need to

restart the corresponding service.
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On my computer, for some reason I

also needed to restart the network

management service. Perhaps the

power management system also

shuts down the WiFi card, though

this is just me speculating:

root@ubuntu:~# service
systemd-logind restart

root@ubuntu:~# service
network-manager restart

root@ubuntu:~# exit

ubuntu@ubuntu:~$ nm-applet &

Once this is done, everything

just worked - for me. For others, on

different hardware, WiFi drivers

may become an issue that needs to

be handled in the usual way.

Memory usage is about 780

MBytes, including the basic

system, the Unity desktop

manager, Firefox, and the rather

memory-hungry Google Drive web

editor, which is to be expected

since it makes an intensive use of

JavaScript. It can be noted I had

virtual memory turned on for this

computer. The LiveCD has

detected the swap partition from

an existing installation on the hard

drive, and is using it for some extra

space. This does seem to speed

things up a little since less page-

swapping occurs when our RAM is

nearly full.

On the other hand, the

processor is getting hit rather

hard. The bottom of the netbook

got quite toasty, as both cores

were used consistently. Part of the

fault does not in fact lie with the

system itself or the programs, but

rather with the integrated graphics

processor on these CPUs. The GPU

in the Atom runs either at 200 or at

400 MHz - i.e. quite slowly. Its lack

of processing power when

calculating overlays and other

graphic effects must be completed

by the main CPU itself, which does

tend to run hot as a consequence.

It may be noted that, as a

result, battery life in these

conditions may be greatly reduced.

The computer is also running on a

battery that was manufactured

back in 2009, so with less capacity

than modern batteries and also

not at its best due to much use

during the intervening years.

Logically, one way to use less

resources is to adopt a less power-

hungry desktop manager. One of
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the leaner versions of Ubuntu

comes with the MATE desktop, so

that was what I decided to install

on this machine. The installation

itself worked flawlessly, even

though I made things slightly more

interesting with a combination of

ext4 (/boot) and btrfs (/, /home)

filesystems.

As expected, memory usage is

lower with this desktop manager.

With the same Firefox + Google

Drive workload, usage went down

a good 1 00 MBytes, which may not

seem much but can make the

difference between the system

needing to swap, or not. Swapping

out pages of memory to the hard

drive is a slow process.

Processor usage was also down

by quite a bit, leading to a slightly

cooler underside for the computer,

and less fan noise for the user.

Even using an office application

such as LibreOffice Writer works

well on this one - better, in fact,

than Google Drive since the RAM

requirements are slightly lower.

Once we have established that

Ubuntu 1 6.04 may be used on this

class of hardware, some tuning

may be undertaken. Perhaps the

area in which most gains could be

expected would be through a

processor swap. But it is indeed

unfortunate that netbooks have

CPUs soldered onto the main

board, that simply cannot be

changed - unlike a desktop

computer. On the other hand, both

memory and the hard drive can

usually be easily exchanged.

On the RAM side of things,

most netbooks came with a single

module of PC-5300 DDR2 RAM.

Many modules were of only 1

GByte capacity, though others held

2 GBytes. Since many netbooks

contained only a single memory

slot, upgrading from 1 to 2 GBytes

may mean somehow sourcing a 2

GByte memory module - which may

not be easy. Needless to say, they

are generally considered obsolete

and not usually carried anymore,

and if you do find them it may be

at stupid prices. Cannibalizing

another, non-functional, netbook

may be of use here.

However, care should be taken

to use only the appropriate type of

memory. SO-DIMM PC-5300 DDR2

RAM running at 333 MHz may be

the most common type, but it is by

no means the only one found out

in the wild. The label on the

module itself usually conveys the

necessary information, and

memory module form factors also

tend to be different, helping figure

out which modules may or may not

be installed in which computers.

As for hard drives, there is a

tendency nowadays to swap

laptops’ original “spinning platter”

drives for Solid-State (SSD) drives -

and, with offerings such as this 1 20

GByte model for less than 50 Euro,

this type of upgrade certainly

makes sense for modern machines.

Now, we may consider the fact

that operating systems such as

Windows or OS-X usually weigh in

at a minimum of about 20 GBytes

of disk space, whereas Linux

variants may have ample disk

space with just 5 GBytes, or even

less. Ubuntu just uses the disk

rather less than other operating

systems, reading in and writing out

less data at each system boot. So

the gain obtained through

switching to a speedier SSD, while

certainly noticeable, is not as

extreme as that obtained under

those other, heavier, operating

systems.

As for netbooks, unfortunately

their main boards were usually

designed to give adequate support

for platter-type hard drives, which

means typical data transfer speeds
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in the 80 to 1 00 MByte/s range. A

SATA-I connection is certainly up to

that, topping out at 1 50 MByte/s.

However, modern SSD drives can

usually spit out data at 250 to 300

MBytes/s, requiring the faster

SATA-I I (300 MBytes/s) or SATA-I I I

(600 MBytes/s) connections. If the

computer’s main board is only

capable of SATA-I , at best the hard

drive will be limited to just 1 50

MBytes/s - and at worst will simply

not be recognized by the

computer, which is what happened

to my Aspire. So a best-case

speedup of only about 2x may be

expected by changing the hard

drive, much less than that

experienced on higher-grade

machines with SATA-I I or -I I I

interfaces that can go up by 4x or

5x.

But this should not dissuade us

from swapping the hard drive. As

stated above, prices on SSDs have

really gone down, to less than 1

Euro per Gigabyte especially for

the lower capacities. Even if our

netbook cannot handle the extra

speed and will be limited mostly by

the slow processor, there will be

some advantages to having a new

drive. One is that the original hard

drive that came with the netbook

may be getting on quite a bit in

age by now, and so may in all

probability fail on us at some

point. Another is that SSDs have no

moving parts, may survive falls and

other accidents even while being

used, and so are better suited to

computers that get hauled (and

banged) about quite a lot during

the working day. However, care

must be taken either to source an

SSD that also accepts SATA-I

connections, or to ensure that the

netbook's chipset handles at least

SATA-I I .

Ubuntu 1 6.04 has been hailed

as the version of Ubuntu that will

achieve convergence across many

different platforms. While this is

certainly true, perhaps we users

should also be aware that the need

to cater for hardware with varying

levels of performance has no

doubt brought about a new

awareness within the developer

community that certain previous

versions of Unity were simply too

slow. There has been a salutary

reaction from developers. Things

have certainly been turned around,

and this newest version (for now)

has regained some of the terrain

lost. I have no precise numbers in

front of me, but there is a distinct

feeling that Ubuntu 1 6.04 is no

heavier on a machine than 1 4.04,

and may be distinctly lighter when

using a lightweight desktop

manager such as MATE. Time will

tell, but I get the feeling that 1 6.04

may be one of the keepers.
THE FULL CIRCLE

WEEKLY NEWS

A short podcast (<1 0min)

with just the news. No chit-

chat. No time wasting. Just

the latest FOSS/Linux/

Ubuntu news.

RSS:

http://fullcirclemagazine.

org/feed/podcast

http://fullcirclemagazine.org/feed/podcast
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Last month, our refurbishing

not-for-profit was approached

by a small not-for-profit

community looking for a donation

of used computers. The

organization had recently been

given some space in which to meet

(they’d been meeting in member’s

houses before this) , and now

needed a few computers so

members could learn basic

computer skills. In my original

discussion with the executive, they

mentioned that the organization

had no funding for computers.

After a short discussion about

licensing and what the

organization was looking for, it

dawned on me that a Linux

Terminal Server Project

(http://ltsp.org/) might work for

them. I pulled out a thin client

we’d just received as a donation

and asked the executive if they

were interested in a client/server

setup. The executive seemed

excited at the prospect of getting

thin clients (having worked with

them before), but their timeline

was very short—less than 1 week.

Having never even set up a PXE

network boot server before, I

needed clear instructions: I found

them at Bobby Allen’s Blog:

http://blog.bobbyallen.me/201 5/0

7/1 9/setup-a-ubuntu-1 4-04-lts-

mate-terminal-server-with-ltsp/

For the server, I used a retired

desktop machine that our project

once used as a SAMBA file server.

The server had an Intel Core 2

Quad Q9400 (2666MHz processor)

in it, and 2GB of DDR2 667MHz

RAM. The drives we’d pulled and

wiped a long time ago, so I

installed a pair of matched 80GB

hard drives. Initially I created a

hardware-based RAID mirror (using

the motherboard RAID controller) ,

but I reconsidered the idea and

decided just to ditch the hardware

RAID and clone the installation

drive once I was happy with the

LTSP server setup. (In my

experience people sometimes

have “friends” with good

intentions who install less than

legitimate software on their

computer, cloning the drive would

at least give me some sort of

backup should this happen). I also

pulled the 2 x 1 GB of RAM and

inserted a matched pair of 2GB

sticks for 4GB 800MHz DDR2 RAM.

Initially I understood that the

organization had an existing

Internet connection so I figured

the best thing to do was to set up

the server for DHCP and when I

got to the facility get their system

administrator to set a DHCP

reservation for the server, then

update the SSH keys and the image

that gets built.

There are a few ways to build

LTSP images, but building an image

off an existing installation seemed

like the simplest way to go and

Bobby’s instructions for updating

an image are really clear. Some

LTSP installations need 2 network

interface cards, but Bobby’s

method uses only one card and the

LTSP server acts as a proxy for the

clients. The server acting like a

proxy tripped me up when I first

got LTSP running because I

couldn’t understand why the

clients showed the server address

when I ran the command:

/sbin/ifconfig. After rebooting the

client, I noticed a unique (non-

server) IP address in the bottom

right of the login screen. It’s only

on logging in that the client uses

http://blog.bobbyallen.me/2015/07/19/setup-a-ubuntu-14-04-lts-mate-terminal-server-with-ltsp/
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the server’s IP as a proxy.

Because all the clients would

likely be 32-bit, and it wasn’t likely

that the organization would have

more than 3 or 4 computers, I

chose to install the 32-bit version

of Ubuntu MATE 1 4.04 on the

server.

As with any desktop or server

installation, it’s always a good idea

to update before installing any

new software:

sudo apt-get update

Some LTSP server setups use

the paradigm of letting the server

act as a DHCP server for clients.

Because I didn’t know the

organization’s network setup, it

seemed a better idea to allow their

router to do DHCP, but the server

would act as a proxy for the router

- dnsmasq provides this

functionality. Dnsmasq can be set

up as a DHCP server, but, in this

case, I used it to forward DNS to

the clients.

The LTSP image had to be

deployed to the clients some way.

Bobby mentions in his blog that

dnsmasq can also act as a tftp

server, but that the functionality is

broken in Ubuntu 1 4.04. Ubuntu

actually has a few tftp server

packages in the repositories, but

the one that he used, and that kept

coming up on all the LTSP-related

sites, was tftpd-hpa. Lastly, the

ltsp-server package is needed so

the LTSP client environment can be

built.

sudo apt-get install dnsmasq
tftpd-hpa ltsp-server

The next step is to build the

LTSP image that will be served to

the clients. Because the build

process has to download packages,

this step can take quite a bit of

time, especially on a slow Internet

connection, so be patient. In my

case, I was building a 32-bit version

of Ubuntu MATE because the thin

clients I picked (I actually ended up

using some old HP DC71 00

Pentium 4 based desktops with no

hard drives instead, but more on

this later) were 32-bit, and because

I ’d installed a 32-bit version of

Ubuntu MATE on the server. Build

a 32-bit client using the following

command:

sudo ltsp-build-client --arch
i386

I f you’re building for 64-bit

clients, just remove the --arch i386.

You’ll also need to replace the i386

in several other places with amd64

including the next step, enabling

the DHCP proxy support. For 32-bit

images, run:

sudo sed -i 's/ipappend
2/ipappend 3/g'
/var/lib/tftpboot/ltsp/i386/p
xelinux.cfg/default

Again, if you’re building for 64-

bit, replace the tftpboot/ltsp/i386

with tftpboot/ltsp/amd64. Bobby

also mentions that if you update

your image, something I did

several times, you’ll have to rerun

the above command. (Once I

tested my image on the clients, I

decided to add several graphics

and educational software

packages to the server, rebuilding

built them into the client image)

DNSmasq needs to be set up so

it can act as a proxy for the clients.

At this point, I was stuck because I

had no information about the

organization’s existing Internet

connection. On further discussion

with the executive (and to my

horror) , I found out that the

Internet connection they had was a

wireless connection that someone

was letting them use. Clearly, this

wasn’t going to work, even with

only 3 clients, they’d choke on a

54g wireless connection. We had a

discussion about getting a wired

connection, and I set up the rest of

the LTSP configuration based on a

wired router we had sitting around

the shop. I also grabbed a 5-port

gigabit switch. Although the router

has 4 ports (in addition to the

Internet port) , all the ports were

1 0/1 00, so I connected the router

and all the clients to the 5-port
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gigabit switch. I set the router to

hand out DHCP in the 1 92.1 68.80.x

address range. My

/etc/dnsmasq.d/ltsp.conf file

looked like that shown right.

Again, if you’re building a 64-bit

image, replace i386 with amd64 in

the line:

pxe-service=x86PC, "Boot from
network",
/ltsp/amd64/pxelinux

With dnsmasq set up, it was

only a matter of restarting the

dnsmasq service and booting the

thin clients (or so I thought).

Restart dnsmasq by running:

sudo service dnsmasq restart

I turned on the thin clients, they

started to network boot and

download the Ubuntu MATE image

and I ended up staring at a black

screen… After a bit of research, I

discovered the thin clients actually

had a bit of storage on them, so I

installed Ubuntu MATE directly on

the storage and booted them to

the same result -- it seemed that

these particular clients didn’t like

to work with Xorg without further

configuration. At this point, it was

the last chance I ’d get to work on

the system before having to

deliver the news to the executive. I

pulled out an old (but reliable) HP

DC71 00 Pentium 4-based

computer we used to use as public

computers, and set it up to boot

(the first picture in this article

shows the computer with the top

of the case off) from network and

voila, it successfully booted to the

LTSP login screen.

Now I was left wondering

“what’s the default login username

and password?” Google might be

your friend, but it wasn’t mine that

night until it dawned on me just to

use the credentials I used to set up

the server - and it worked! The

next problem I ran into was that

when I ran /sbin/ifconfig on the

client computer it displayed the I .P.

address of the server. This didn’t

make sense at first because I

thought it should display the an

address unique to the client. I

thought I ’d done something wrong

when in fact things were working

exactly as they should be. Once

the client logs in to the server it

actually is using the resources of

the server and the proxy we set up

was working as it should be. The

clue that things were working

correctly happened when I

rebooted and noticed that each

client does indeed get a unique I .P.

########################################
# Dnsmasq running as a proxy DHCP
########################################

#
# TFTP
#
#enable-tftp
#tftp-root=/var/lib/tftpboot

#
# DHCP
#
dhcp-range=192.168.80.0,proxy
# Tell PXE clients not to use multicast discovery
# See section 3.2.3.1 in http://tools.ietf.org/html/draft-henry-remote-boot-protocol-00
dhcp-option=vendor:PXEClient,6,2b
# Better support for old or broken DHCP clients
dhcp-no-override
# Enable this for better debugging
#log-dhcp

#
# PXE
#
# Note the file paths are relative to our "tftp-root" and that ".0" will be appended
pxe-prompt="Press F8 for boot menu", 3
pxe-service=x86PC, "Boot from network", /ltsp/i386/pxelinux
pxe-service=x86PC, "Boot from local hard disk"
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LINUX LAB
address that’s displayed in the

bottom right of the LTSP login

screen.

The last problem I ran into was

the fact I was using the LTSP server

administrator credentials to log in

to the server. When I went to shut

down the client, and typed in the

server admin credentials, I also

shut down the server. To fix the

problem I added a non-

administrative account to the

server. Clients would use this non-

administrative account to log in.

But as hinted at earlier, when you

make changes you want

incorporated into your image you

have to rebuild:

sudo ltsp-update-image

sudo sed -i 's/ipappend
2/ipappend 3/g'
/var/lib/tftpboot/ltsp/i386/p
xelinux.cfg/default

These commands need to be

run every time you want to rebuild

the client image based on a change

on your server. Remember to

replace the i386 with amd64 for

64-bit images. I found myself

updating the image several times

before I got it to a point where I

thought I had the right mix of

software for the community

centre.

After work one evening, I

headed to the community centre

with one of the executives to

install the server. The centre had

already taken 3 clients. The centre

still didn’t have a wired Internet

connection, but we set up the

network and ran through some of

the installed programs so they

could get their members started

learning keyboard skills (klavaro, I

found tuxtyping to be too slow on

the clients) . When the centre gets

a wired connection, I ’ll be revisiting

them to reconfigure their server

for whatever router is giving them

DHCP (I ’ll add a DHCP reservation

for the server on the router) . At

that point, it will also be necessary

to update the ltsp ssh keys, and

update the image:

sudo ltsp-update-sshkeys

sudo ltsp-update-image

sudo sed -i 's/ipappend
2/ipappend 3/g'
/var/lib/tftpboot/ltsp/i386/p
xelinux.cfg/default

I t’s exactly the same process for

updating the image with the

exception of updating the ltsp ssh

keys first.

I ’ve asked the community

centre executive to keep me in the

loop to help members, and a

person of their choosing with

training to administer the server.

The centre hasn’t officially opened

at the time of this article, so I

expect I ’ll have a lot more to write

about in a future article. It’s worth

noting that I didn’t have a problem

playing sound on clients, but ran

into issues with USB devices.

Initially I couldn’t get USB devices

recognized on the clients. With

some searching, I managed to fix

the problem, but then ran into the

problem of not being able to get

the drives to unmount without

administrative privileges.

I also tried a system with a Core

i5 processor as a client, and was

surprised to find that it wasn’t that

much faster – slightly faster to

boot, but not much of a

discernable difference running

software (because the server is

handling almost all of the load).

LTSP RESOURCES:

LTSP home page:

http://www.ltsp.org/

Ubuntu LTSP community help:

https://help.ubuntu.com/communi

ty/UbuntuLTSP

Bobby Allen’s blog:

http://blog.bobbyallen.me/201 5/0

7/1 9/setup-a-ubuntu-1 4-04-lts-

mate-terminal-server-with-ltsp/

Enabling USB and other local

devices:

https://wiki.ubuntu.com/EnableLTS

P5LocalDevices

http://www.charlesmccolm.com/
http://www.ltsp.org/
https://help.ubuntu.com/community/UbuntuLTSP
http://blog.bobbyallen.me/2015/07/19/setup-a-ubuntu-14-04-lts-mate-terminal-server-with-ltsp/
https://wiki.ubuntu.com/EnableLTSP5LocalDevices
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Written by Ronnie Tucker

N o great, or important, Ubuntu

device news this month. Next

month we will have OTA-1 1 .
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Finally, we get our hands on an

Ubuntu tablet; the BQ Aquaris

M1 0 Ubuntu Edition. The tablet

comes in two flavors (more on that

shortly) , and if you pre-ordered it

(like I did) then you also receive a

cover and screen protector.

The M1 0 is, more importantly,

the first Ubuntu device (in fact, any

device) which can do the magical

convergence trick that’s so often

talked about with Ubuntu Touch.

Convergence is, simply put, one

device that can have multiple uses.

For example; alone the tablet is

just that (a tablet) , but with the

addition of a bluetooth keyboard

and mouse, the OS will adjust

accordingly (giving you a desktop

look) and you now, in effect, have a

laptop. Output the tablet to a

screen and you have the makings

of a desktop machine.

SPECS

As stated earlier, there are two

versions; an HD version, and a Full

HD (FHD) version. The HD comes in

white, the FHD in black.

Both have 1 0.1 ” screens, are

246 x 1 71 x 8.2mm in size, weigh

470g, use a 1 6:1 0 aspect ratio,

have 1 6GB of storage with 2GB of

RAM, micro-SD slots (on the top

edge) with micro-HDMI and micro-

USB OTG slots on the left side, and,

with them, a headphone jack. The

right edge has the power and

volume buttons. Both have

bluetooth 4, accelerometer,

ecompass, brightness sensor, GPS,

WiFi (dual-band) and come with

Ubuntu 1 5.04 OTA-9. Upgradable

to OTA-1 0.1 on first boot.

Obviously, they differ in

resolution: the HD has 1 280x800

while the FHD has 1 920x1 200.

The HD has a MediaTek

QuadCore MT81 63B CPU at 1 .3GHz

while the FHD has an MT81 63A at

1 .5GHz. Both have Mali-T720 MP2

GPUs with the HD’s being 520MHz

and the FHD at 600MHz.

They also differ with the HD

rear camera being 5MP, FHD being

8MP. Front camera on the HD is

only 2MP while the FHD is 5MP.

Neither come with a micro-

HDMI cable, or OTG cable/hub. So

if you want to try out USB devices,

or hook it up to a screen, you’ll

need to buy some (cheap) extras.

UPDATES

I mentioned that the tablet

comes with 1 5.04. While 1 6.04 has

now been released on the desktop,

it’s not available as yet for mobile

devices. I ’m told that it will come

later in the year, but it’s a big job,

so don’t expect every desktop

Ubuntu update to appear on your

mobile device. But, don’t worry,

1 5.04 (and future Touch versions)

for mobile devices is still being

looked after and you’ll receive

Over The Air (OTA) updates every

month or two. As I write, 1 0.1 is

the latest update.

Updating is done by simply

going to the System Settings >

Updates, and you’ll see software

and OS updates in here.

For more on using the OS itself,

see my review of the Meizu MX4
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phone. It’s the exact same

software.

SIDE STAGE

A new feature found only on

the tablet is side-stage. This is

where you can have two apps on

the screen side by side. The one on

the right is overlapping the one on

the main screen.

This is done by opening the app

you want at the right side of the

screen then, with three fingers,

dragging the app to the right of

the screen. As soon as you move

your three fingers across the

screen you see a drop zone for the

side-stage app.

Obviously, how well an app

looks in side-stage is up to the

developer. So don’t worry if things

look a bit odd at first. It’s a handy

feature to have your email (in

Dekko), or the File Manager,

always there at the side of the

screen.

CONVERGENCE

Adding a keyboard and mouse

is when the magic starts to

happen. The Ubuntu Touch OS

switches into what it calls

‘windowed mode’ where your

scopes/apps become windowed
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and everything looks more like the

familiar Ubuntu.

You now effectively have a

laptop.

Pushing the mouse to the left

edge of the screen will show the

Unity side strip with the Ubuntu

(ie: home) button and the apps you

have open, or have pinned to the

side. Pushing to the right brings in

the switcher to let you choose

other open apps (or to close apps).

And, in short, you use the apps

like you would if it were a

desktop/laptop.

I should also mention that

plugging in an OTG cable/hub with

a USB mouse/keyboard will trigger

the desktop mode too. I also tried

a wireless keyboard/mouse with

USB dongle and it worked fine too.

Heck, I even tried a gimmicky

bluetooth laser projection

keyboard and it worked!

Speaking of desktops…

plugging in a micro-HDMI to HDMI

cable between the tablet and a

TV/monitor will pop the tablet into

its third mode. This is the same

display as the laptop/windowed

mode, but now you’re using a

bigger screen. The reason it’s a

third mode is that the tablet
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screen now goes blank (your

display is on the TV/monitor) and

the tablet screen now becomes a

touchpad.

You can, if you want, keep the

mouse/keyboard attached and

have all the bells and whistles you

could ever want.

In one of my photos, and I

apologise about the quality of

them but it’s very difficult to photo

a TV/tablet, you’ll (hopefully!) see

a USB stick plugged into an OTG

hub which is plugged into the

tablet (which also has the

keyboard/mouse dongle). While

you can use USB sticks, be aware

that you do need to install the File

Manager from the Ubuntu Store

(for free) and unlock the File

Manager (from its menu) to gain

read/write access to the stick.

This is also a good time to say

that not all USB hardware will

work. Some draw too much power

from the tablet and just won’t

work. I tried my Wacom tablet,

and, while it lit up, it wasn’t

recognised. Also bear in mind that

if a USB device does work, it may

drain the battery very quickly.

LEGACY APPS

But the tricks don’t end there.

There’s more!

Pre-installed on the tablet are a

couple of (what’s known as) legacy

apps. The apps are fully working

versions of GIMP, LibreOffice,

Firefox, Gedit and Gchat desktop

apps!

That’s right. You can use fully

functioning GIMP, LibreOffice, etc.

on the tablet.

NOTE: as of writing, and OTA-1 0.1 ,

there is a bug whereby the legacy

apps can’t use the on-screen

keyboard and need a hardware

keyboard. This is a known bug and

is being worked on.

One quirk of legacy apps is that

they’re, for want of a better term,

sandboxed. So, for example, they

can’t see USB sticks. This means

you need to save your LibreOffice

document to the tablet then

copy/paste it to the USB stick in

the File Manager. It’s a bit of a

nuisance, but nothing major.

I haven’t tested plugins in GIMP,

but I did try addons with Firefox

and the addons installed, and

worked exactly as expected. While

on the subject of Firefox, things

like YouTube and Vimeo in Firefox

are very stuttery, but fine (even at

full screen) using available apps

from the store. Netflix is,
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unfortunately, a no go.

SUDO APT

I know what you’re thinking:

great! So I can sudo apt my

favourite software on the tablet?

Uh. No. The tablet uses the

ARM processor. In short: it won’t

run bog standard desktop apps

without them being possibly

rewritten, recompiled and/or

repackaged.

If you should happen to have an

app that’s ARM compatible then

I ’m told that OTA-1 1 will bring a

way to install it using a nice GUI

app on the tablet.

CONCLUSION

Pros

• Lovely looking tablet.

• Side-stage handy for keeping eye

on email/etc.

• Convergence is great. One tablet,

multiple uses.

• Works well with OTG hubs, USB

(kb/mouse), Bluetooth devices,

etc.

Cons

• No sync between devices. The old

Ubuntu One cloud storage would

have been handy now.

• No file/document manager by

default. You need to install them

from the store.

• As of writing, the legacy apps are

a bit slow.

• Can’t install any old app.

• Charging can take a couple of

hours. Even from the mains.

• Small text in desktop apps.

The M1 0, and convergence, are

great ideas, but non-geeks might

be better waiting for OTA-1 1 +.

Having no file, or document,

manager by default seems a bit

odd as they’re something most

people would need. Thankfully

they’re only a few pokes away in

the Ubuntu Store.

I do hope they can get more

speed into the legacy apps as

they’re a bit slow. Having said that,

I did load up one of my larger,

multi-layer, GIMP files, and it was

completely usable and I could still

apply complex filters quite quickly,

considering it’s a tablet.

Not being able to install just

any desktop app will definitely be a

deal breaker for most people, so I

hope there’s some easy, or easy-

ish, way that this can be rectified.

All in all though, I ’m still very

happy with the tablet. I ’m looking

forward to future updates as, like

the phones, it can only get better.

Ronnie is the founder and (still! )
editor of Full Circle. He's a part-time
arts and crafts sort of guy, and now
an Arduino tinkerer.
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Python Crash Course: A Hands-

on, Project-Based Introduction to

Programming

By Eric Matthes

January 201 6, 528 pp.

Publisher: No Starch Press

ISBN: 978-59327-603-4

This book came to me just as I

was having multiple physical

issues and after two ER visits, one

surgery and some recuperation

time (and issues) , I ’m finally

getting to finalize this review. The

sheer size of the book (528 pages)

was, at first, a bit daunting because

many books this size are on a level

that is either so full of disjointed

facts, thoughts and ramblings that

it is dryer than the Sahara and one

has to be an archeologist to dig out

the information, or written in such

a way as to come very close to

insulting the reader's intelligence.

Happily, Eric didn’t produce

either of these types of books, but

one that balances between the

two. The layout of the material is

well done. Part 1 gives more than

the “normal” basics of Python

programming in some 230 pages,

which includes setting up the

programming environment for the

basics, all the way to writing test

cases and code in a very clear and

logical manner.

Eric’s Project-based section

includes such things as using

PyGame to create a game like Alien

Invaders, using matplotlib and

pygal for data visualization, and

creating web-based applications

using Django. All of these projects

are well thought out and

presented in such a way that

learning the subject matter and

implementing it is much more an

enjoyable pastime rather than an

onerous task that must be

completed. Eric took the time to

deal with some rather complex

projects and lay them out in a

consistent, logical and pleasant

manner that draws the reader into

the subject willingly, which

unfortunately, many authors fail to

do.

In Eric’s Appendices, he covers

various text editors, how to get

help, and using GIT (something I ’ve

been meaning to discuss for years,

but never quite got there, so BIG

THANKS, Eric) .

All in all, I have to give this book

a 5 out of 5 star count! I ’m happy

to include this into my private

library for a very long time.

Table of Contents
Part I : Basics
Chapter 1 : Getting Started
Chapter 2: Variables and Simple Data

Types
Chapter 3: Introducing Lists
Chapter 4: Working with Lists
Chapter 5: if Statements
Chapter 6: Dictionaries
Chapter 7: User Input and while Loops
Chapter 8: Functions
Chapter 9: Classes
Chapter 1 0: Files and Exceptions
Chapter 1 1 : Testing Your Code

Part I I : Projects
Project 1 : Alien Invasion
Chapter 1 2: A Ship that Fires Bullets
Chapter 1 3: Aliens!
Chapter 1 4: Scoring

Project 2: Data Visualization
Chapter 1 5: Generating Data
Chapter 1 6: Downloading Data
Chapter 1 7: Working with APIs

Project 3: Web Applications
Chapter 1 8: Getting Started with

Django
Chapter 1 9: User Accounts
Chapter 20: Styling and Deploying an

App
Afterward
Appendix A: Installing Python
Appendix B: Text Editors
Appendix C: Getting Help
Appendix D: Using Git for Version Control
Index
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If you would like to submit a letter for publication, compliment
or complaint, please email it to: letters@fullcirclemagazine.org .
PLEASE NOTE: some letters may be edited for space.

SPEAKING KLINGON

I ’m a relative newbie to Linux. I 've

played around in older versions

of Ubuntu. However, I am yet to be

admitted to the inner sanctum

where phrases such as SUSE,

Debian, REDHAT, Grub, Unity, GNU,

and many others, are used with

unquestioning authority. However,

to me they may as well be in

Klingon as they are just so much

gak to me. Maybe an introductory

‘Dummies’ article would help

demystify some of these terms and

I ’d feel more at home here. While

my Unix background is helpful, (a

long time user of fruit-inspired

products) there is still much to be

learned.

Owen McCarthy

DEEPIN MIRRORS

J ust a short comment on the

Deepin OS review: Yes, the

downloads from the "Deepin

Technology Ltd" servers (I believe

in Shanghai) can be anciently slow.

However, there are mirror

servers; I use the one from Kent

University-UK providing download

speeds as usual from elsewhere (in

the UK). I was advised about the

mirror servers via the Deepin

Forum site.

Frank Dinger

BQ M1 0 TABLET

J ust viewed the YouTube on the

BQ M1 0

(https://www.youtube.com/watch?

v=6LGmq38G0to). I just received

one this week. It is everything you

say! One more plus: I live in the

USA in central Ohio, and received

the M1 0 shipped from Spain in less

than a week from the day I ordered

it. And the shipping was free. The

unit with Duo Case and 2 screen

protectors cost me 299 Euros or

about $330 – a bit pricey for a

Tablet, but I am a fan of the Linux

OS and want it to prosper.

I bought the M1 0 for my wife.

Neither of us has used a Tablet,

but the large cumbersome

Windows 1 0 laptop she uses is

slow and, for her, confusing. She's

finding the M1 0 has a relatively

brief learning curve even though

she's not a cyber whiz.

I 've been an Ubuntu fan, though

no Linux expert/nerd, for a few

years now. For my desktop, I 'm

using a MintBox2 I got from an

Israeli manufacturer. My laptop is a

used Dell E641 0, I bought cheap,

on which I also use the latest Mint

version. I 've yet another old

Toshiba NB505 that I 'm using with

a new installation of the latest

version of Lubuntu. This minimalist

Ubuntu works really great on a

machine without much to offer.

Ron Payne

VOICE INTERFACE?

I would like to use voice mainly asthe interface with a computer.

Any progress on using Cortana,

Siri , Google or other bots on

Ubuntu? A simple request that

would probably need a vast

amount of work.

Tom

Join us on:

facebook.com/fullcircle

magazine

twitter.com/#!/fullcirclemag

linkedin.com/company/full-

circle-magazine

ubuntuforums.org/forum

display.php?f=270

goo.gl/FRTMl

FULL CIRCLE NEEDS YOU!

Without reader input

Full Circle would be an

empty PDF file (which I don't

think many people would find

particularly interesting). We

are always looking for articles,

reviews, anything! Even small

things like letters and desktop

screens help fill the magazine.

See the article Writing for Full

Circle in this issue to read our

basic guidelines.

Have a look at the last page of

any issue to get the details of

where to send your

contributions.

mailto:letters@fullcirclemagazine.org
http://facebook.com/fullcirclemagazine
https://twitter.com/#!/fullcirclemag
http://linkedin.com/company/full-circle-magazine
http://ubuntuforums.org/forumdisplay.php?f=270
http://goo.gl/FRTMl
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Compiled by Gord Campbell

If you have a Linux question, email it to: misc@fullcirclemagazine.org , and
Gord will answer them in a future issue. Please include as much
information as you can about your query.

Q I was finally able to get a

separate (third) drive for

Ubuntu. What I would like is, every

time I turn on the computer, I get

the option of which OS I boot into.

I think the solution is to use a

bootloader, but I have no idea how

to pick one or even know if this is

right. I have Windows 1 0 and

Ubuntu 1 5.1 0.

A When you install Ubuntu, it

will install the GRUB

bootloader. If you choose

"something else" during

installation, you can specify where

it should go. Select the first drive

in your BIOS/UEFI boot order. You

will need to use the drive sizes to

figure out which drive is which.

Probably the one with Windows

will be first, identified as SDA.

Probably Ubuntu will go on the

third drive, SDC.

Since it is very easy to get this

wrong, make sure you have an

image backup of your system, and

a way to restore the image, before

you do anything! Macrium Reflect

Free is a good program for doing

this.

Q I've just upgraded one of my

machines to 1 6.04, and now,

on installing Folding@Home, I get

a Python error.

A (Thanks to khowe in the

Ubuntu Forums) wget

http://launchpadlibrarian.net/1 090

52/python-support_1 .0.1 5_all.deb

sudo dpkg -i python-
support_1.0.15_all.deb

Not sure why it doesn't install

automatically, maybe a bug report

is in order.

Q I have a dual boot system,

Windows 7 and LXLE. Can I

toss out LXLE and put Ubuntu

Mate on my machine?

A During installation of any

member of the Ubuntu family,

you will reach a point where it asks

where you want to place the

installation: erase disk, alongside

the existing system, or something

else. Select something else.

You will see a list of the

partitions on your hard drive.

Select the one where LXLE resides

and click on "change." Specify "use

as" EXT4. Select the mount point

"/" (root) and click on the box to

format the partition, and OK.

Q I have been trying to run

Picoscope under Wine,

unsuccessfully.

A See this page:

https://www.picotech.com/do

wnloads

It says there is a picoscope for

Linux. Since you need drivers for

the computer to get data from the

'scope, there is almost zero chance

you would get it running in Wine.

Q Whilst upgrading to 1 6.04, I

was informed that removing

old packages may take several

hours. I didn't take the removal

option at the time as I didn't have

the time to wait. Is it advisable to

remove them and if so how do I do

it?

A (Thanks to deadflowr in the

Ubuntu Forums)

sudo apt-get autoremove

will show all packages no longer

needed. I think apt's man page

makes a nice point about whether

to remove or not to remove.

Q I have two security cameras

and would like to know if I can

attach them to my network and

use some kind of software on my

server machine to record the

video. Also a way to remotely view

it on an iPhone.

A (Thanks to volkswagner in

the Ubuntu Forums)

Zoneminder works with most IP

cameras (need to send mpeg

stream).

There is a paid app (zmNija) in

Android and Apple app stores, that

integrates well with ZM. You'll

want to use the Ubuntu PPA for

use of zmNija.

mailto:misc@fullcirclemagazine.org
http://launchpadlibrarian.net/109052/python-support_1.0.15_all.deb
https://www.picotech.com/downloads
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Gord had a long career in the
computer industry, then retired for
several years. More recently, he
somehow found himself "The IT Guy"
at a 1 5-person accounting firm in
downtown Toronto.

Q&A

Q Is Synaptic package manager

installed by default on Ubuntu

Mate version 1 6.04?

A No, but it's easy to install

post-installation of Mate.

Q I clearly remember

downloading different debs

and just click installing. This is not

working for me anymore.

A Install Gdebi and use it to

install .deb files.

Q I have a pack of fonts which I

would like to add to Ubuntu

1 4.04. How can I do this?

A (Thanks to CantankRus in the

Ubuntu Forums) If you have

only one user, you can place them

in ~/.fonts

That folder probably does not

exist, so you have to create it. Then

run this command:

sudo fc-cache -fv

I f you want to make the fonts

available to multiple users, you

need to put them in

/usr/share/fonts which requires

using sudo. Then run the same

command.

TOP QUESTIONS AT

ASKUBUNTU

* Is there any program for fuzzy

string matching, which provides a

match score?

http://goo.gl/xnLFAf

* What is the 'Badlock Bug'?

http://goo.gl/9wcaL1

* What is the name of the security

concept that explains why Linux

asks for root password?

http://goo.gl/Fi0ehH

* How do I install and manage

GNOME Shell extensions?

http://goo.gl/sx3ES3

* Why doesn't the latest Ubuntu

edition come with the latest stable

Linux kernel version?

http://goo.gl/N8748p

* How to run a Python program

directly?

http://goo.gl/vjHloF

* Ubuntu Server 1 6.04 installs on

/sdc but fails to boot

http://goo.gl/zdG27C

* No more boot logging since

1 6.04?

http://goo.gl/r4RuvP

* Personal computer hacked: How

do I block this user from logging in

again? How do I find out how they

are logging in?

http://goo.gl/A39P3E

TIPS AND TECHNIQUES

Really?

Asmy bio says, I work part time

in a mostly Windows

environment. It's an accounting

firm, and the typical desktop

system has nearly 200

"applications" installed; all of them

are Windows only. A new client

walks in and says, "I haven't filed a

tax return for a dozen years, and I

have income in both Canada and

the U.S." That's 24 "applications"

right there.

The company has aligned itself

with two primary software

suppliers. This makes tremendous

sense, and simplifies the IT

workload.

One of the software suppliers

has a no-charge add-on to its

mainline product, which is very

attractive. It's a "portal" for

transferring files between clients

and the firm, and it ties in nicely to

the main product. When a new

client asks, "how can I send you

files," having a standard answer is

very powerful.

The software is free. However,

the suggested configuration is to

have a separate server in its own

"DMZ", which means a new router,

a new computer, a new Windows

Server license, a new domain name

and a new SSL Certificate. The

most expensive part of this? The

Windows Server license! Argh!

http://goo.gl/xnLFAf
http://goo.gl/9wcaL1
http://goo.gl/Fi0ehH
http://goo.gl/sx3ES3
http://goo.gl/N8748p
http://goo.gl/vjHloF
http://goo.gl/zdG27C
http://goo.gl/r4RuvP
http://goo.gl/A39P3E
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QQ&&AA II II :: TTHH EE XXEENN II AALL LLAAUU NN CCHH
Compiled by Gord Campbell

Michael Kaulback hosted an

Ubuntu launch party on April

21 in Toronto, Canada.

In addition to providing

cupcakes and coffee, Michael (who

is genii on IRC) proved his chops by

helping to install Ubuntu 1 6.04,

Xenial Xerus, on a nasty little X86-

based tablet.

About 20 people attended, with

a range of interest levels. A couple

were merely considering using

Ubuntu, while others could delve

into the internals.

Almost half the people brought

computers, most of which were

five to seven years old. Based on

this small sample, it seems that any

old computer with at least 2 GB of

memory can run any member of

the 'Buntu family reasonably well.

For more pictures:

https://goo.gl/photos/FfUmX1 i54R

z2kncL6

Photo caption : John Kerr (left) and Gord Campbell represented Full Circle Magazine at
the Toronto Xenial Xerus launch party.
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http://www.meizu.com/en/ubuntu/features.html
http://bq.com
http://www.meizu.com/en/products/pro5ubuntu/summary.html
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UU BBUU NN TTUU GG AAMMEESS
Written by Oscar Rivera

Over the last couple of years,

Linux gamers have gotten

quite the flurry of games ported

over to Linux, and lately, some

games have even been released for

Linux at the same time as they're

released on other consoles.

However, not a single true fighting

game had been made available for

Linux users until now.

Move over Street Fighter and

go chill with Mortal Kombat and

your other pals, because Skullgirls

has arrived! Skullgirls is a 2D

fighting game developed by

Reverge Labs (later renamed Lab

Zero due to some financial and

legal issues). It was originally

released in 201 2 for Xbox360 &

Playstation 3, then, in 201 3, it was

released for Windows PC. Lots of

Skullgirls fans, myself included,

kept requesting a Linux port, and,

in October 201 5, it finally arrived

on Linux as well as Mac OS X. The

game was ported by a few

dedicated fans who worked hard at

making it available on Linux, but,

after playing the game, you could

never guess that the game was not

originally intended to be played on

Linux. The game runs as smoothly

as any other Linux native game,

which was something of a concern

for me when I heard that the

original game developers were not

involved in the Linux port. It was a

small number of volunteers and a

yet-to-be-named company who

made the Linux port – not only

playable and enjoyable but also as

perfect as it could get. On behalf

of the Ubuntu gaming community,

I 'd like to thank you.

Anyone who's played titles such

as the aforementioned Street

Fighter, Mortal Kombat, or other

fighting titles, will feel right at

home playing Skullgirls. The game

provides various modes of play

depending on your needs. There is

a single player campaign story-

based mode, an arcade mode, a

training room, and a single player

versus, as well as a two-player

versus mode that can be played

online. I have played all of the

different modes available, and

there are very subtle differences

between them. The online versus

mode is fun because you get to

play against another player, but I

would recommend going through

some of the tutorial, single player

versus (or arcade), or even the

story mode first, if you're planning

on not getting badly beaten right

away. Some of the players you'll

encounter online on a good day are

quite good; however, other times

there may not be as many players

available online due to the game

having had its initial release so

long ago. The tutorial as well as

the training room are great at

learning and then improving your

skills. Also, for some odd reason, if

you decide to use a game

controller, the button layout is

rather unorthodox and it may take

some time getting used to it (the

same holds true for all other

consoles as well as PC/Mac

versions). It's almost like some of

the control layouts are slightly

counter-intuitive, but once you get

used to them, they are not that

hard to use and understand.

Skullgirls can currently be

bought through Steam or through

the Skullgirls website for around

$9.99 at the time of this writing.

There are a total of eight playable

SSkkuu llllgg ii rrllss
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UBUNTU GAMES

characters in the standard edition

(yes, all of them girls) . If you want

to buy the Skullgirls 2nd Encore for

$1 4.99, then you get an additional

five characters as well as all sorts

of other added goodies. The five

added characters can also be

bought separately for $1 .99 each,

which would be an additional $1 0

for all five characters. By buying

the Skullgirls 2nd Edition, you not

only end up saving $5.00, but you

also get a few added bonuses – so I

would recommend paying a bit

more for the 2nd Encore to get

your money's worth. Some of

these added characters are girls,

but some (such as Big Band and

Beowulf) are not. Like all fighting

games, each character has its own

way of doing the basic moves (low

kick, mid kick, high kick, low block,

mid block, high block, etc) . But,

more importantly, each character

has its own set of special moves

which you'll have to memorize if

you want to be able to perform

them at will instead of by chance.

It's not terribly hard to perform

special moves; it just takes some

time to get used to the button

combinations for each character.

The story mode (as well as all

other modes for that matter)

revolve around the Skull Heart and

the power it can grant its owner.

All eight Skullgirls are trying to get

the Skull Heart back from Marie

who is the nemesis of the game. I

first started with the tutorials,

then went on to the arcade, story,

and finally versus and versus online

modes. The story mode tells you a

little bit about each character's

past and why she wants to acquire

the Skull Heart from Marie. The

seemingly hand-drawn characters,

as well as the intricate background

art, in combination with the fast

jazz-meets-punk spy music, have a

certain quality to them that adds

to its post-prohibition, cyberpunk,

feel – which is reminiscent of the

James Bond and Operation:

Impossible fictitious eras.

Surprisingly, I have not come

across any deal-breaking glitches

yet. I say surprisingly because it's

my understanding that the Linux

port was initially begun by a small

number of Skullgirls fans and

finished by a still unknown

company. The only negative aspect

of the game I would say has

already been worked out with the

2nd Encore additions. Many

people, myself included, used to

complain about a short story-

mode, and a lack of playable

characters, but for only $5 more,

that issue has now been resolved. I

still strongly believe that for the

low price of $1 4.99, you get a good

quality fighting game with lots of

replay value even after completing

the story and arcade modes.

This is a game that I most

definitely recommend if you're

looking for a fighting game,

especially since as of now Street

Fighter has only been promised

but not yet delivered. You will not

regret getting this game unless

you object to the outfits the girls

are wearing in the game.

Minimum System Requirements:

OS: Ubuntu 1 5.04 / Fedora 22 /

SteamOS

Processor: Dual-core CPU

Memory: 2 GB RAM

Graphics: Intel HD3000*

Network: Broadband Internet

connection

Storage: 5 GB available space

Additional Notes: *MESA drivers

1 .6.0 and 1 .6.1 are not supported,

please update to 1 .6.2.
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PONG Wai Hing
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Rene Hogan
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Marcos Alvarez Costales

Raymond Mccarthy

Max Catterwell

Frank Dinger

Paul Weed

Jaideep Tibrewala

CHA CHA CHA CHANGES

Our admin went AWOL for months, and
I had no idea if/when the site
would/wouldn’t get paid. Initially the
plan was to move the site and domain
name to my hosting, but eventually I
managed to track him down and get
the FCM domain name, and site hosting
transferred to me.

The new site is now up. HUGE thanks to
Lucas Westermann (Mr. Command &
Conquer) for taking on the job of
completely rebuilding the site, and
scripts, from scratch, in his own time.

The Patreon page that I ’ve set up is to
help me pay the domain and hosting
fees. The yearly target was quickly
reached thanks to those listed on this
page. FCM is not going away. Don’t
worry about that.

Several people have asked for a PayPal
(single donation) option, so I ’ve added
a button to the side of the site

A big thank you to all those who’ve
used Patreon and the PayPal button.
It’s a big help.

https://www.patreon.com/

fullcirclemagazine

https://www.patreon.com/fullcirclemagazine
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HH OOWW TTOO CCOONN TTRRII BBUU TTEE
Full Circle Team

Editor - Ronnie Tucker

ronnie@fullcirclemagazine.org

Webmaster - Lucas Westermann

admin@fullcirclemagazine.org

Editing & Proofreading

Mike Kennedy, Gord Campbell, Robert

Orsino, Josh Hertel, Bert Jerred, Jim

Dyer and Emily Gonyer

Our thanks go to Canonical, the many

translation teams around the world

and Thorsten Wilms for the FCM logo.

FULL CIRCLE NEEDS YOU!
A magazine isn't a magazine without articles and Full Circle is no

exception. We need your opinions, desktops, stories, how-to's,

reviews, and anything else you want to tell your fellow *buntu users.

Send your articles to: articles@fullcirclemagazine.org

We are always looking for new articles to include in Full Circle. For help and advice

please see the Official Full Circle Style Guide: http://url.fullcirclemagazine.org/75d471

Send your comments or Linux experiences to: letters@fullcirclemagazine.org

Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org

Questions for Q&A should go to: questions@fullcirclemagazine.org

Desktop screens should be emailed to: misc@fullcirclemagazine.org

... or you can visit our site via: fullcirclemagazine.org

FCM#1 1 0
Deadline:

Sunday 05th June 201 6.

Release:

Friday 24th June 201 6.

EPUB Format - Most editions have a link to the epub file

on that issues download page. If you have any problems

with the epub file, email: mobile@fullcirclemagazine.org

Issuu - You can read Full Circle online via Issuu:

http://issuu.com/fullcirclemagazine. Please share and rate

FCM as it helps to spread the word about FCM and Ubuntu.

Magzster - You can also read Full Circle online via

Magzster: http://www.magzter.com/publishers/Full-Circle.

Please share and rate FCM as it helps to spread the word

about FCM and Ubuntu Linux.

Getting Full Circle Magazine:

For the Full Circle Weekly News:

You can keep up to date with the Weekly News using the

RSS feed: http: //ful lcirclemagazine.org/feed/podcast

Or, if your out and about, you can get the Weekly News

via Stitcher Radio (Android/iOS/web):

http: //www.stitcher.com/s?fid=85347&refid=stpr

and via TuneIn at: http: //tunein.com/radio/Ful l -Circle-

Weekly-News-p855064/
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